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Introduzione
 
BBLogger è un nuovo software per gestire la propria Stazione Radioamatoriale o di ascolto. Il programma è completamente gratuito
e può essere liberamente distribuito ad altri Radioamatori / SWL a condizione che non venga modificato in alcuna sua parte.
Il programma gira su macchine con Sistema Operativo Windows 2000 / XP / Vista / 7 / 8 e con .Net Framework 2 o superiore.
Nel caso non sia installato, .Net Framework 2 si può scaricare gratuitamente dal sito Microsoft:

http://www.microsoft.com/it-it/download/details.aspx?id=1639
Il programma gira anche su Windows 98/ME a patto che vengano installati i seguenti programmini: MDAC_TYP.EXE,
DCOM98.EXE e JET40SP8_9XNT.EXE. I seguenti files possono essere scaricati dal sito www.aribusto.it (cliccare su DAI ->
SOFTWARE DAI -> SCARICA VISUAL DAI) dato che sono gli stessi necessari per far girare Visual DAI con Windows 98/ME.
Per il momento non è stato testato su altri Sistemi Operativi. Attenzione: una volta installato il programma parte in Inglese: per
commutare sulla lingua italiana o su altre lingue supportate basta andare su Tools > Configuration/Maintenance > Utility e
selezionare  Language > ITALIANO o altra lingua. Sono disponibili: ITALIANO, ENGLISH, DEUTSCH, ESPAÑOL, FRANÇAIS e
POLSKI

ATTENZIONE! Se il vostro Sistema Operativo è Windows Vista, Windows 7 o
Windows 8 dovete lanciare il programma con i privilegi di amministratore: dopo

l'installazione click con il tasto destro del mouse sull'icona di BBLogger > "Esegui
come amministratore"

Una volta scaricati i files zippati vanno semplicemente decompressi in una directory temporanea o sul Desktop. Dopodiché basterà
lanciare il SETUP del programma. Questa è la configurazione che dovreste avere:
 

Video Tutorial INSTALLAZIONE (italiano) 1a

parte

Video Tutorial INSTALLAZIONE (italiano) 2a

parte
 

https://translate.google.com/
http://www.microsoft.com/it-it/download/details.aspx?id=1639
http://www.aribusto.it/
http://www.youtube.com/watch?v=uMr6lmV1WBs
http://www.youtube.com/watch?v=16SHYO5-5b4


 
Non preoccupatevi se non vedete tutte le sottocartelle, le creerà il programma una volta avviato. Controllate anche la presenza dei
seguenti files nella sottocartella FilesDataBase:
 

 



E nella cartella FilesAward dovreste avere un discreto numero di files del medesimo tipo di questi (files di Access), che sono relativi
ai vari Awards gestiti dal programma. Questi files sono protetti da password dato che il contenuto è proprietà degli autori e non deve
essere né alterato né divulgato a terzi per scopi diversi dall'utilizzo in questo programma.
 
Se tutto è a posto potete cominciare: Avvio Software

http://www.aribusto.it/BBHelp/avvio.htm
http://www.aribusto.it/BBHelp/IndexBBH.htm
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Avvio del programma
 
A questo punto siete pronti per il primo avvio del programma: il programma di installazione crea un'icona sul vostro desktop. Per
lanciare BBLogger basta dare un doppio click sull'icona. Per gli utenti di Windows Vista e Windows 7 e 8: se doveste
incontrare difficoltà nel funzionamento del programma, potete configurarlo per essere eseguito in modalità
compatibilità Windows XP. Cliccate sull'icona di BBLogger sul desktop con il tasto destro del mouse e selezionate
Proprietà. Cliccate sulla linguetta Compatibilità e spuntate la casella "Esegui il programma in modalità
compatibilità per" -> Windows XP. In ogni caso assicuratevi di lanciare il programma con i privilegi di
amministratore. Click col tasto destro del mouse sull'icona di BBLogger sul Desktop e poi "Esegui come
amministratore".
Una volta lanciato il programma, si aprirà questo box:

 

 
Ovviamente cliccate su SI e si aprirà quest'altra finestra:
 

 
Compilate quindi tutti i campi in OM Data e scegliete dal menu a discesa la vostra condizione (OM / YL / Clubstation / SWL). In OM

https://translate.google.com/


Service dovrete inserire il vostro indirizzo e-mail, il gestore di posta in uscita (esempio out.alice.it) ed eventualmente la password
che usate normalmente per la posta elettronica (alcuni sistemi la richiedono). La sezione QSL service è per chi è iscritto a eQSL.cc,
e LoTW: inserite i parametri per l'invio automatico delle eQSL. La sezione Log Service è per chi è iscritto a HRDLOG, ENZOLOG e
CLUB LOG: inserite i parametri relativi. Salvate tutto.
Massimizzate ora la finestra del programma e cliccate su LOG nella barra in alto a sinistra e poi selezionate NUOVO LOG:
 

 
In automatico il box propone il call che avete inserito nella fase precedente, e in NOME DEL LOG potete inserire quello che volete,
mentre in TIPO LOG dovrete selezionare HUNTER (cioè il log di casa) oppure EXPEDITIONER (se state attivando un'abbazia, un
castello, un'isola, ecc.) o SWL. A seconda del tipo di log che avrete scelto muteranno le caratteristiche operative. Il checkbox
presente nel box va spuntato se intendete inviare in tempo reale quando salvate i QSO a HRDLog.net, a Enzolog e/o a Club Log (se
siete registrati presso questi siti) e/o a eQSL.cc. Con l'opzione MY FAVOURITE MODE BANDS potete selezionare le bande e i modi
che utilizzerete per quel log. E' comunque sempre possibile modificare le scelte in un momento successivo. Il programma consente
di inserire più User , nel caso vogliate gestire callsign diversi dal vostro call abituale, come contest call, call barrati, eccetera.

Attenzione: e possibile inserire tutti i nuovi modi di emissione digitali che verranno proposti in Custom Digi Modes semplicemente
cliccando sul tasto giallo  +MODE, scrivendo il nuovo modo, cliccando su DataLog e salvando con OK. Nell'esempio seguente è
stato aggiunto il modo FT8
 

 
Una volta creato il log, dovremo riempirlo. Se desiderate importare il vostro vecchio log da un altro programma assicuratevi di averlo
esportato come file ADIF. Cliccate ora su FILE in alto a sinistra nella barra dei menu poi su FILES MANAGER: si aprirà ina finestra
come questa: IMPORT ADIF FILES consente l'importazione di un log in formato ADIF. E' possibile indicare anche un intervallo di
date per l'importazione, spuntando la relativa casella e definendo le date. Le due opzioni in basso consentono una corretta
identificazione del Country. Se l'ADIF contiene il DXCC Code esso verrà utilizzato per attribuire l'entità DXCC, altrimenti il
programma tenterà  di decodificare il callsign. Con Verifica automatica DXCC verranno importati quei QSO in cui non vi sono dubbi
sul Country, mentre verranno generati un file di testo e un file ADIF secondario relativo ai QSO con Country dubbio (esempio VP8,
che viene usato per stazioni di Falkland, South Shetland, South Georgia, South Orkney, South Sandwich e Antarctica). Questo file
ADIF può essere esaminato ed importato in una fase successiva utilizzando l'opzione Verifica Manuale DXCC:  il programma
chiede conferma all'utente circa il Country DXCC da inserire per ogni QSO contenuto in questo ADIF secondario. Questa operazione
potrebbe essere piuttosto lunga. La procedura automatica importerà il vostro log alla velocità media di circa 1000 QSO al minuto, ma
la velocità effettiva dipende dal processore della vostra macchina. Se si vuole verificare subito il proprio log si può optare per la
Verifica manuale nella prima fase di importazione del log. La finestra sottostante consente di tenere sott'occhio il processo e nella
finestra parallela "QSO not imported" vengono visualizzati i QSO che non sono stati importati. Facendo doppio click su quello
desiderato si può aprire e correggere quel QSO. E' possibile che nonostante questa doppia lettura si verifichino casi di attribuzioni di
COUNTRY errati: significa che la procedura automatica non è stata in grado di decodificare quel Country dal prefisso (ad esempio
Russia Europea o Russia Asiatica) oppure potrebbe accadere con i prefissi dell'ex Unione Sovietica, cambiati più volte e assegnati a
Country diversi, ad esempio Russia e Ucraina. Il programma è in grado di riconoscere il Country a partire dal prefisso ma, dato che il



cambio di prefisso non è stato simultaneo, è possibile che nel periodo di transizione lo stesso prefisso sia stato usato da Country
diversi, e in alcuni casi l'algoritmo di decodifica può dare assegnazioni sbagliate. Altre volte sono stati assegnati prefissi speciali che
il programma non è in grado di riconoscere, in questo come negli altri casi occorre dopo la conversione esaminare il log e fare le
correzioni manualmente. Se nel campo comment dell'ADIF importato sono presenti REFERENZE IOTA, REFERENZE DCI o
REFERENZE DAI, queste potranno essere importate nei rispettivi campi del log con la procedura  Strumenti >
Configurazione/Manutenzione > Award Auto Checking. Naturalmente le referenze devono essere scritte esattamente come sono
scritte nei database. Le due caselle presenti consentono di aggiornare i campi QSLs e COMMENT nel caso di QSO duplicati. Tipo
File serve per selezionare il tipo di file che verrà importato. La scelta è fra ADIF Generico, per importare la maggior parte dei log in
ADIF, ADIF Confirm eQSL per importare le conferme eQSL (ricordiamo che questo è l'unico modo per aggiornare la propria
situazione eQSL ricevute), ADIF Confirm LoTW per importare il file di conferma da LoTW. Vi sono poi altre due opzioni: TXT Credit
DAI e TXT Credit DCI: questi sono i files di conferma che vengono ricevuti dai Manager DAI e DCI, e servono per accreditare
automaticamente le referenze dei rispettivi diplomi. ADIF eQSL Card Image  importa i file immagine-QSL da www.eqsl.cc , File
Report WWFF importa i crediti per il Diploma WWFF e File Report WCA fa lo stesso per il Diploma WCA. Infine l'opzione ADIF
LoTW Granted importa i crediti LoTW. Quando importiamo un file adif Generico o da eQsl, i qso not in log sono riportati nella griglia
del file manager. Se desideriamo forzarne il salvataggio nel log, facciamo doppio click sul qso interessato e si aprirà la normale
finestra di inserimento qso con i dati. Premere salva per inserirlo nel log.
 

 
Con ESPORTA LOG IN FILE si possono esportare i propri file in formato ADIF per ogni scopo, selezionando la casella Copia nei
Commenti e scegliendo l'Award desiderato si possono esportare le referenze relative a quell'Award nel campo Comment del file adif
generato. Tipo file consente di scegliere tra un ADIF generico e i file specifici da inviare a LoTW, eQSL.cc. HRDLog, Enzolog o
Club Log. Mediante QSOs Filter possiamo selezionare se esportare tutti i QSO oppure solo quelli per i quali non si è ancora spedita
la QSL..
 

 
Nella sezione eQSL/DM780/QRZ.com vengono gestite le comunicazioni con il sito www.eqsl.cc, con il programma DM780 se
installato, e con il sito www.qrz.com. Nel riquadro UserName della sezione eQSL scriveremo il nostro callsign e nel riquadro
Password la password con la quale accediamo al sito www.eqsl.cc Con il pulsante Download eQSL file report si possono
importare i file dei Crediti da eQSL.cc per gli utilizzi legati a questo tipo di procedura. Per i dettagli si veda la pagina relativa alle

http://www.eqsl.cc/
http://www.eqsl.cc/
http://www.qrz.com/
http://www.eqsl.cc/


procedure eQSL La finestra sottostante consente di linkare il file prodotto dal programma DM780 per l'importazione dei QSO
registrati in BBLogger. E' anche possibile importare i QSO registrati con il programma DM780 fornendo il relativo path. La sezione
Link to QRZ.com consente di interfacciare il programma con QRZ.com. Per fare questo bisogna inserire prima il proprio User ID
(normalmente il proprio Callsign) e la Password che si usa per accedere alla propria pagina su QRZ.com. A questo punto basta
cliccare su Create QRZ Link per importare la propria Keyword che consente di recuperare le informazioni da QRZ.com. L'accesso
completo ai dati è possibile mediante sottoscrizione al servizio da effettuarsi presso il sito di QRZ all'indirizzo:
http://www.qrz.com/XML/ altrimenti si avrà un accesso parziale ai dati (solo nome e cognome).
 

 
Nel caso abbiate sottoscritto il servizio QRZ potete usare questo in tempo reale, in alternativa al Callbook su disco: per fare questo
andate in Strumenti>Configurazione/Manutenzione e spuntate il box relativo a QRZ. Dalla release 1033 è possibile avere i dati in
automatico da HamQTH, in alternativa a QRZ spuntando il relativo box. Naturalmente potete sempre ricavare i dati manualmente
durante l'immissione del QSO da QRZ.com con ALT+Invio e da HamQTH con Shift+Invio
 
La sezione LoTW Management introduce la gestione LoTW: si rimanda alla pagina LoTW per spiegazioni più dettagliate.
 

 
La sezione WWFF/HRD-DM780 comprende a) la gestione WWFF mediante: 1) creazione del link con il sito WWFF (il colore verde
indica che il link è stato creato); e 2) importazione e processo del file di accredito WWFF. I QSO verranno automaticamente
accreditati e un file di errori sarà eventualmente generato in formato TXT ; b) l'importazione in BBLogger dei QSO salvati dal
programma DM780
 

http://www.aribusto.it/BBHelp/procedure_eqsl.htm
http://www.qrz.com/XML/
http://www.aribusto.it/BBHelp/procedure_lotw.htm


 
Se invece vogliamo creare un log Expeditioner, selezioneremo il tipo di log dal relativo menu a discesa. Ci verrà chiesto che cosa
stiamo attivando, ad esempio un'isola: immetteremo la referenza NA156 e selezioneremo IOTA nel relativo menu a discesa. E' solo
un promemoria, non è vincolante, possiamo anche lasciare il campo bianco, nel caso il diploma relativo non sia fra quelli del menu a
discesa. Avremo quindi questo tipo di schermata:

 

 
Nella casella COMMENTI possiamo inserire quello che vogliamo, ad esempio potremmo scrivere il nome dell'Isola che stiamo per
attivare. Per tutti i QSO verrà inserita questa stringa nel campo Comment.
Attenzione: i log Expeditioner sono necessariamente più spartani dei log Hunter, per esempio non sono implementati i
campi per gli Award. Tenetene conto quando riversate i vostri log di tipo Expeditioner nel vostro log generale! Andate a
rivedere i QSO e se è il caso completateli per gli Award che desiderate seguire.
Salvate poi le vostre scelte e andate alle Impostazioni

http://www.aribusto.it/BBHelp/impostazioni_iniziali.htm
http://www.aribusto.it/BBHelp/IndexBBH.htm
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Impostazioni iniziali
Prima di partire ad inserire i QSO, bisogna settare le impostazioni di base del programma: dal menu STRUMENTI selezionare
CONFIGURAZIONE/MANUTENZIONE:

 

 
CALLBOOKS dà la possibilità di settare il Callbook da cui il programma attinge le informazioni. Se si vuole usare il RAC (Radio
Amateur Callbook) bisogna dargli il path, esempio D:\, C:\RAC, eccetera. con il tastino \... si può effettuare la ricerca del file da
agganciare e il programma automaticamente assegnerà il path. WORLD.DBF consente di utilizzare Worldcall di IK1MTT, in questo
caso la procedura da seguire è la seguente: per prima cosa bisogna creare una cartella DATI e copiare in essa i seguenti tre files:
WORLD.DBF, WORLD.NDX e WORLD.INF, che troverete nella cartella DATI del CD di IK1MTT. Dal 2014 Worldcall è distribuito
non più via CD ma on-line. Per info scrivere all'autore Marco: m.marconetto@tiscali.it Se non è presente il file WORLD.INF potete
realizzarlo molto semplicemente: aprite il blocco note e scrivete queste due righe: prima riga: [dbase], seconda riga:
NDX=WORLD.NDX. Salvate con il nome WORLD.INF. Si possono settare anche due o più Callbooks. Il programma effettuerà
ricerche multiple. In questo caso la ricerca sarà però più lenta. Se avete installato nel vostro computer il programma Radamato di
I0SSH, Logger può interfacciarsi con esso. Usate sempre il tastino \... per agganciare il file corretto e salvate con OK. 
ON-LINE CALLBOOK consente di selezionare QRZ o HamQTH come callbook on-line, se si è connessi in rete. QRZ prevede un
abbonamento per ottenere i dati completi. HamQTH è invece gratuito.

 

 
La sezione UTILITY ha diverse funzioni:
Il tasto CHECK LOG QRB consente di riesaminare il proprio log per inserire il QRB (naturalmente si presume che i Locator inseriti
siano esatti). Il tasto CHECK LOG FREQ consente di inserire automaticamente la frequenza nei contatti già registrati con la sola
banda. Il campo Frequenza è stato inserito con la release 1.0.1.8. Naturalmente saranno inserite le frequenze di default, es. 14.000
per il 20m, 21.000 per i 15m, ecc. Il tasto SET LOG TX PWR consente la revisione del log aggiungendo la Potenza del trasmettitore,
secondo quanto selezionato per i vari modi con i box al centro della finestra, ai contatti già registrati prima di questa novità, il tasto
QSO DEF. consente di impostare la potenza di default per i vari modi indicati. Il tasto CHECK LOG DXCC consente di rivedere il
proprio log e assegnare il corretto Country ad ogni QSO. Il programma ricerca quei QSO con stazioni con call "ambigui" ossia con
quei prefissi utilizzati per più di un Country DXCC, come GB, VP8, eccetera. Questa utility è particolarmente adatta per chi ha già
importato il proprio log e vuole verificarne la correttezza. Se non si desidera apportare delle variazioni al Country già registrato con
quel QSO basta premere ESC. Dopo il controllo verrà prodotto un file di testo denominato CheckLogError_data e ora consultabile
nella directory FilesLog. Se non si desidera apportare variazioni basta premere Esc. Naturalmente è sempre possibile forzare un

https://translate.google.com/
mailto:m.marconetto@tiscali.it


Country se non è presente fra quelli proposti con l'apposita procedura (vedi Inserimento QSO). Il tasto CHECK LOG MANAGERS
consente di inserire in automatico il Manager, se presente nel database interno dei Manager, per quei QSO che hanno la casella
vuota. E' possibile aggiungere per ogni controllo anche il filtro data. I due tasti DATABASE BACKUP e DATABASE RESTORE si
riferiscono all'archivio DB_LOG.MDB che contiene tutti i log di stazione. Il BACKUP avviene mediante compressione del log e viene
aggiunta la data in cui il backup viene eseguito (in formato YYYYMMDD) nel nome del programma, es. BBLBKP_20090301.ZIP.
Naturalmente si può selezionare la cartella dove il backup dovrà essere conservato. Il programma inoltre propone sempre il backup
alla fine di ogni sessione di lavoro, l'utente può decidere se effettuare il backup o meno. A partire dalla Release 1.0.2.4. vengono
salvati, oltre all'archivio log, anche i file "INI" relativi a BBLogger e a BBTerminal. Questi file contengono tutti i vostri settaggi, in
caso di reinstallazione del programma non avrete bisogno di rifare i settaggi daccapo: basterà copiare i file INI nella cartella di
BBLogger.

 

 
La sezione AWARD AUTO CHECKING è una importantissima utility che consente di aggiornare automaticamente il vostro log sulla
base di un Callbook per inserire informazioni utili per la gestione di svariati Award. Vedremo questa importante utility in dettaglio
nella sezione AWARD MANAGER

 

 
La sezione PREFERENCES consente di selezionare la LINGUA e il FONT preferiti, e se i documenti prodotti saranno in Excel
(Microsoft Office) o in Calc (Sun Open Office).

Poi vi è un menu che consente di selezionare lo status di default per quanto riguarda la QSL da spedire.

Se Default QSLs è su N viene selezionato per default QSLs = N e quindi tutti i nuovi QSO finiranno nel buffer di stampa per
etichette o QSL.

Se Default QSLs è su I invece viene selezionato QSLs = I e quindi i nuovi QSO non non verranno copiati nel buffer di stampa per
etichette/QSL.

Naturalmente le impostazioni di default possono essere variate durante il QSO (F2) e anche dopo (F4).

Sono presenti tre checkbox: 

Non inviare la QSL per lo stesso call/band/mode che, se spuntato, pone QSLs = I (Ignore) per QSO con Call già collegati sulla
stessa banda e nello stesso modo;

Auto Complete Favourite Callsign che se spuntato consente l'autocompletamento in fase di inserimento QSO (F2) di quei
Callsign;

http://www.aribusto.it/BBHelp/inserimento_qso.htm
http://www.aribusto.it/BBHelp/award_manager.htm


Internal Web Browser che consente di aprire finestre internet all'interno del programma in cartelle affiancate alla cartella "Mainlog".

Edit QSO with... consente di scegliere se utilizzare la funzione F4 oppure il doppio click per riaprire/editare un QSO dalla griglia.
In alternativa si aprirà la visualizzazione/inserimento della QSL per quel dato QSO: se si seleziona Edit QSO with double click
allora F4 visualizza l'immagine QSL, e viceversa.

Marker on log eQSL cfm / LoTW cfm consente di visualizzare con fondo blu chiaro le conferme eQSL o alternativamente, le
conferme LoTW nel foglio log. Attenzione: per vedere la colorazione è necessario che le relative colonne eQSL e LoTW siano
visibili nel foglio log.

 

 
Per finire la sezione FAVORITE WEB LINKS contiene alcuni link utili

 
Una volta effettuati i settaggi si può esaminare ora la struttura del programma: Desktop

http://www.aribusto.it/BBHelp/desktop.htm
http://www.aribusto.it/BBHelp/IndexBBH.htm
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Il Desktop
 
Il desktop è suddiviso in tre aree ridimensionabili a piacere dall'utente: il Foglio Log propriamente detto nella parte inferiore:
 

 
La finestra Packet Cluster nella parte superiore sinistra:
 

 
E infine la FINESTRA DELLO SPOT che reca tutte le informazioni trasmesse da chi ha postato lo spot, nella parte superiore destra. La finestra contiene anche il
nome del Country DXCC , il QRB, e il bearing dell'antenna, via corta e via lunga. All'arrivo di uno spot viene mostrata la propria situazione nei vari modi operativi
per quel Country nella banda segnalata dallo spot, i colori hanno il seguente significato: BIANCO = non lavorato, ROSSO = collegato non confermato, VERDE =
confermato, GIALLO = confermato via LoTW, AZZURRO = accreditato dal DXCC Desk.

https://translate.google.com/
http://www.aribusto.it/BBHelp/foglio_log.htm
http://www.aribusto.it/BBHelp/terminale_packet_cluster.htm
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Il Foglio Log
 

 
Il foglio log si presenta come in figura, con la barra dei comandi in testa. Il menu COLONNE LOG consente di scegliere tra colonne
autodimensionate oppure colonne dimensionate manualmente, inoltre dà la possibilità di visualizzare le colonne che ci interessano e
di posizionarle nell'ordine che vogliamo. Tutte le colonne si possono ordinare alfabeticamente in senso diretto (A-Z) o contrario (Z-A),
le colonne numeriche ovviamente seguiranno l'ordinamento dei numeri. La colonna data può ordinare i nostri QSO dal più recente al
più vecchio oppure dal più vecchio al più recente. Non tutte le colonne esistenti nel database sono visualizzate: le colonne relative
agli Award sarano visualizzate nella sede opportuna (sezione Award). Per spostarsi più velocemente nel campo DXCC una volta
sia stato ordinato alfabeticamente, possiamo usare la combinazione Ctrl+lettera dell'alfabeto. Se ad esempio premiamo Ctrl+N la
selezione si sposta sul primo QSO del primo Country in ordine alfabetico che inizia con quella lettera, nel nostro esempio sarà la
Namibia. Da COLONNE LOG è possibile scegliere il carattere da usare, la sua dimensione e il suo stile, e il numero di record che
verranno mostrati. Questo riguarda solo la visualizzazione in quanto tutti i confronti relativi ai call vengono effettuati su tutto il log
attivo. Mediante questo menu possiamo anche cambiare lo stile della barra di intestazione del foglio log.
Gli altri tasti della barra dei menu sono i seguenti: NUOVO QSO (F2): apre la finestra di immissione dati QSO; RICERCHE (F3):
apre la finestra delle ricerche, che possono essere condotte con svariate chiavi; QSLs e QSLr: gestiscono le QSL inviate e ricevute;
il tasto RAC lancia il programma RAC, Radio Amateur Callbook se il relativo disco è nel drive, oppure se se ne è trasferito il
contenuto sul disco rigido; il tasto MANAGER apre la finestra di ricerca dei manager con l'apposita finestra. Sia direttamente sul
foglio log, mediante i menu QSLs e QSLr, che dalla finestra delle RICERCHE (F3) si può gestire la nostra situazione QSL. Dalle
Ricerche cliccare su una riga con il tasto sinistro del mouse: il fondo diventa BLU. Poi cliccando con il tasto destro del mouse
appare un box che permette di scegliere l'opzione:
QSL ricevuta via Bureau = Y,
QSL ricevuta per via Diretta = D
QSL respinta (QSLr = I) N.B. I sta per Invalid
Questa operazione muta il colore di fondo della griglia log dal colore di base BIANCO per i QSO non confermati e con QSL ancora
da spedire (QSLs e QSLr = N) a:
VERDE nel caso il QSO sia confermato (QSLr = Y oppure D per la via diretta)
Vediamo adesso il significato degli altri colori del fondo della griglia log:
GIALLO indica i QSO per i quali abbiamo spedito la QSL (QSLs = Y oppure D)
ROSA indica i QSO per i quali non spediamo la QSL (QSLs = I) e non ancora confermati (QSLr = N) N.B. I sta per Ignore
ARANCIO indica i QSO confermati ma con nostra QSL ancora da spedire (QSLs = N e QSLr = Y, D)
GRIGIO indica i QSO per cui la nostra QSL ci è stata ritornata: not in log, not member, unclaimed, silent key, ecc (QSLr = I) N.B. I sta
per Invalid
AZZURRO indica i QSO confermati solo via eQSL. Questa colorazione compare solo se si sono rese visibili le colonne eQSLs e
eQSLr.
Vi è un'altra opzione per QSLs indicata dalla lettera O, che sta per OQRS: significa che abbiamo richiesto la QSL via Internet (On-
line QSL Request). Selezionando questa opzione il colore di fondo diventa OCRA. Questa opzione è più che altro un promemoria
per ricordare che la richiesta è stata ef fettuata con tale metodo. Una volta ricevuta la QSL il fondo muterà in verde come per tutti i
QSO confermati con QSL cartacea.
Ogni QSO è modificabile mediante selezione  MODIFICA QSO (F4) oppure cancellabile con l'opzione CANCELLA QSO . Il menu
compare con click del tasto destro del mouse, e comprende una terza opzione:  STATUS DXCC, che fornisce la situazione DXCC
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relativa a quel Country.
La gestione delle eQSL è autonoma, così come la gestione LoTW.
E' possibile la selezione multipla dei QSO tenendo premuto il tasto MAIUSCOLO e selezionando i QSO con il tasto sinistro del
mouse o con Freccia Giù.  Usando il mouse basta premere con il tasto sinistro sul primo e sull'ultimo record e verranno selezionati
tutti i QSO compresi nell'intervallo. Invece tenendo premuto il tasto CTRL si possono selezionare col tasto sinistro del mouse ad uno
ad uno QSO non consecutivi.
Una volta effettuata la selezione, mediante il tasto destro del mouse si apre un sottomenu da cui si possono selezionare 3 opzioni:
RICAVARE DATI DA CALLBOOK: effettua una ricerca sul callbook prescelto e completa i dati dei QSO (attenzione: questa opzione
cancella e riscrive i dati immessi)
CANCELLA QSO: per eliminare massivamente dei QSO
MODIFICA QSO SELEZIONATI: questa opzione apre il seguente modulo, in cui è possibile modificare per i QSO selezionati i
seguenti parametri:
 

 
Data, Modo, Banda, Status QSL spedita, Status QSL ricevuta, RST dato, RST ricevuto, Manager, Commento, Propagazione,
Data di invio della QSL e Data di ricevimento della QSL.
Il file del log si chiama DB_LOG.MDB e normalmente si trova nella cartella FilesDataBase, ma possiamo porlo in qualsiasi cartella a
nostra scelta.
 
Selezionando un QSO e dando un doppio click oppure premendo F4 (a seconda della scelta operata in
Manutenzione/Configurazione > Global Settings) si aprirà una finestra dove potremo salvare e visualizzare uno scan della QSL
relativa a quel QSO, per costituire un Album di QSL virtuali. Allo stesso modo in questa cartella saranno immagazzinate le eQSL
ricevute e scaricate con la procedura descritta nella sezione eQSL
 

 
Con il tasto Open QSL Image è possibile aprire uno scan della QSL relativa a quel QSO e associarlo al QSO mediante il tasto Save
QSL Image . Al momento del salvataggio verrà richiesto se l'immagine è il fronte (F) o il retro (B) della QSL. E' possibile associare
due immagini ad ogni QSO, per il fronte e il retro della QSL, oppure per QSL cartacea ed eQSL. Mediante il tasto Turn Image è
possibile visualizzare alternativamente queste due immagini, e mediante i tasti del mouse è possibile effettuare uno Zoom In oppure
uno Zoom Out dell'immagine. Questo tool è disponibile anche dalle griglie di ricerca e degli Awards, sempre con doppio click (o F4
secondo quanto selezionato nelle preferenze Global Setting di Configurazione/Manutenzione del menu Strumenti). La presenza di
un'immagine è evidenziata dall'icona . Queste immagini sono immagazzinate nella sub-directory QSLimage ma se si
desidera, si può cambiare il path.
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Inserimento QSO
 

 
Questa è la finestra di inserimento QSO: nel box CALL si inserisce il nominativo o mediante digitazione o per doppio click sul call che appare nella finestra di SPOT.
(Attenzione: perché questo avvenga il checkbox Spot > QSO in SETUP > ALERTS della finestra Packet Cluster deve essere spuntato). Se volete cancellare il call e i dati
per introdurne degli altri senza salvare, procedura detta di Refresh, basta dare un doppio click sulla striscia gialla Info oppure premere CTRL+Z. Consigliamo vivamente
questa procedura invece del semplice cambio di Nominativo nella finestra CALL perché in questo modo saranno azzerati tutti i dati e non si correrà il rischio di mantenere
dati errati nell'immissione di un secondo call. I dati nei campi Nome e QTH vengono attinti dal Callbook oppure da QRZ.com in abbonamento. Vedi Avvio Software  per i
settaggi del Callbook. Il tasto CAT BKT serve per interfacciare i programmi di CAT di IZ2BKT. Mediante il tasto F10 è possibile consultare il database interno e con F11 il
database on line di IK3QAR per cercare un manager. Con il tasto Show Manger on Qrz si apre la pagina di quel manager su www.qrz.com per eventuali info. Il tasto Ins
Mng serve per inserire un manager nuovo. Il tastocon una piccola stella a fianco del campo CALL serve per memorizzare i call che si sentono frequentemente. Essi
andranno a costituire un piccolo archivio e saranno richiamabili da menu a tendina nel caso in Preferences sia stato spuntato il relativo checkbox. I QSO possono essere
loggati in tempo reale  A  oppure differito  M . Normalmente i QSO vengono messi a log con il TIME OFF aumentato di un minuto rispetto al TIME ON, tuttavia se si
desidera la precisione negli orari di inizio e fine QSO la procedura è questa: all'inizio del QSO premete il tasto F7, in questo modo TIME ON viene bloccato mentre TIME
OFF si aggiorna con il clock del computer e quando salverete il QSO l'orario di fine QSO sarà corretto. Se abbiamo abilitato le procedure di invio automatico del QSO ai
Log on line e/o a eQSL.cc, quando il QSO sarà salvato, sarà anche inviato in tempo reale. V edi Avvio Software
 

 
 Anche un doppio click nella griglia dei FILTERED SPOTS fa aprire la finestra di Inserimento QSO.
 

 
Nel caso si digiti il call, premendo Invio o Tab il programma ricerca i dati nel Callbook interno (RAC, Worldcall o Radamato) la ricerca sarà rivolta al CD o al disco rigido.
Peraltro sul RAC e Worldcall non è possibile trovare call speciali o call di DXpedition rilasciati di recente. Se avete settato RAC o Worldcall come callbook e siete connessi
a Internet, non trovando un call potete fare la ricerca su QRZ con la combinazione Alt+Invio. In questo modo verrà aggiornato anche il LOCATOR. Il tasto LookUp
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Qrz.com apre nel vostro browser la pagina di quell'OM in QRZ.com, se presente, in modo da poter vedere eventuali info. Il tasto LookUp Grid apre nel vostro browser una
mappa relativa al quadratino Locator indicato. Ovviamente deve essere quello esatto, importato con la procedura Alt+Invio da QRZ. Il Locator proposto di default, è
puramente indicativo dato che si riferisce alla capitale del Paese oppure della Call-Area, o della sub-area interessata. Invece in QRZ sono i vari utenti ad inserire i loro
Locator corretti. Spot DX consente di aprire un box per inviare uno spot al Cluster. I Modi disponibili sono tutti quelli che sono accettati dall'ARRL per i files LoTW. Il box
Prop è particolarmente rivolto a chi fa traffico via VHF e superiori e/o Satelliti, e consente di indicare il mezzo di propagazione del nostro segnale, es. SAT, EME, MS
(Meteor Scatter), AU (Aurora), ecc. Può anche essere lasciato bianco. Scegliendo SAT si può inserire anche il Satellite utilizzato (nell'esempio AO-10) e il Modo
Satellitare (nell'esempio il Modo B). PWR consente di inserire la potenza del trasmettitore. Un doppio click sulla fascia gialla Info oppure  CTRL+Z produce un refresh
della finestra.
 
VEDI LA TABELLA DI BANDE E MODI DI BBLOGGER
 
Se avremo importato lo spot, la banda e la frequenza saranno settate in automatico, altrimenti dovremo settarla manualmente mediante il menu a discesa. Cambiando la
frequenza cambia anche la banda. Bande, frequenze e modi selezionabili sono quelli che avremo impostato in sede di creazione o di modifica del log. Il tasto CNF to
eQSL consente di inviare automaticamente la eQSL e compare solo se si è riempito l'apposita sezione in Dati User. Naturalmente si possono aggiungere queste
informazioni in un secondo momento con Modifica Dati User da menu Log. Il tasto QSL Manager consente di effettuare una ricerca nel database Manager. Se il manager
è presente nel database il programma lo riporta nell'apposito box, altrimenti occorrerà digitarlo. In caso nel database fossero presenti diversi manager per quella stazione
DX, il programma prenderà quello più attuale. Il tasto QSL Mng OnLine consente la ricerca del manager presso il sito www.ik3qar.it uno dei più aggiornati nel web. Il tasto
Show Manager on QRZ apre una finestra browser caricando la pagina di quel Manager nel sito www.qrz.com . Nel riquadro in alto a destra compaiono le informazioni
relative al Country, alla zona CQ, alla zona ITU, al QRB calcolato in base al nostro locator, e il bearing dell'antenna, short path e long path, oltre alla bandierina di
quel Country. Nella casella gialla INFO compariranno, se presenti, le informazioni relative a quel call, come nell'esempio in immagine la Contea e lo Stato USA. Data e
ora possono essere presi in automatico dal clock del computer (tastino verde con la lettera A) oppure possiamo inserire manualmente questi dati cliccando sul tastino (che
diventerà rosso e mostrerà la lettera M per "manuale"). Il tasto Status DXCC mostrerà la nostra situazione per quel Country nelle varie bande e nei vari modi: il fondo
verde indica contatto confermato, il fondo rosso significa contatto non ancora confermato. Non c'è bisogno di importare lo spot nella finestra di inserimento QSO per vedere
la situazione di un Country che è comparso nella finestra di SPOT: possiamo cliccare F6. Oppure possiamo selezionare uno spot già passato nella griglia FILTERED
SPOTS e cliccare F7. L'esempio seguente si riferisce ad un call portoghese. Cliccando con il tasto destro del mouse sui nominativi che appaiono si possono riaprire i QSO
per vederli/editarli.

 

 
Talvolta può accadere che un determinato Callsign possa appartenere a diversi Country. Si pensi ad esempio al prefisso VP8, che corrisponde a ben 6 diversi Countries:
Falkland, South Georgia, South Orkney, South Shetland, South Sandwich e Antarctica. In questo caso il programma aprirà una finestra con le varie possibilità dando
l'opportunita all'utente di scegliere il Country. Il database contiene molti call di basi antartiche, spedizioni, stazioni di ricerca, eccetera; anche storici per la conversione dei
propri log, ma naturalmente non può essere aggiornato al minuto, quindi se si rende necessario cambiare il Country proposto in un altro è sufficiente premere il pulsante
Forza DXCC. Questo anche nel caso di Country che contengono al loro interno più zone CQ e/o ITU, non risolvibili dal Callsign. Il menu a discesa contiene tutti i Country e
per Country con più zone, anche più righe dalla quale potremo scegliere quella che fa al caso nostro. E' il caso di ricordare che il concetto di Country che pervade il nostro
universo di radioamatori è in realtà un'invenzione della ARRL che lo ha introdotto con il diploma DXCC. La ITU assegna agli Stati dei blocchi di prefissi e ogni Stato in tutta
autonomia decide come utilizzarli, e non è certamente tenuto ad utilizzare prefissi diversi in funzione dei diversi Country in cui per l'ARRL è diviso quello Stato. Se accade
tanto di guadagnato, se non accade pazienza.
 

 
Il QSO si può salvare con il tasto Salva QSO nel riquadro, oppure con la combinazione di tasti CTRL+S. Nel caso di un log di tipo Expeditioner il salvataggio è più veloce
e si effettua con il tasto F12.
 
Se inseriamo un call che abbiamo già collegato nel nostro log tipo Hunter, il programma lo segnala mutando il colore del fondo della casella del Call. Se non abbiamo mai
contattato quel Call il fondo rimarrà BIANCO . Se avremo già collegato quel Call sulla stessa banda e nello stesso modo il fondo muterà a ROSSO. Se quel Call è stato già
collegato nello stesso modo ma su banda diversa il fondo diventerà GIALLO. Se invece la banda è la stessa ma diverso è il modo il fondo diventa VERDE. Infine se quel
call è già stato collegato ma su bande e modi diversi il fondo diventa AZZURRO. Comparirà anche sulla barra della finestra inserimento QSO un altro tasto, denominato
Storico Call, premendo il quale comparirà una griglia con tutti i dettagli dei QSO avuti con quel callsign. Se siamo in modalità Expeditioner un reminder ci dirà che quel
call lo abbiamo già collegato. E' possibile comunque proseguire e loggare il QSO anche se doppio.
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Infine i tasti che regolano le QSL, QSLs, cioè QSL inviata o da inviare e QSLr ossia QSL ricevuta. Ovviamente nel caso di immissione QSO ci interesserà il menua a
tendina QSLs che presenta queste opzioni: 
N = QSL non ancora spedita. Questo QSO verrà scritto nel buffer per la stampa della label/QSL con i dettagli del contatto. Per default il buffer di stampa presenta tutte Y
nell'ultima colonna, se desideriamo inviare una o più QSL per via diretta dovremo selezionare una D al posto della Y nel buffer di stampa quando staremo per stampare le
etichette/QSL. (non nel foglio log!)
Y = QSL già spedita (la N muta a Y oppure a D dopo la stampa delle etichette/QSL)
D = indica una QSL già spedita per via diretta. Attenzione: se viene selezionata questa opzione in fase di inserimento QSO, esso non verrà copiato nel buffer di stampa).
Se vogliamo inviare una QSL per via diretta dobbiamo selezionarla dal buffer di stampa. Dopo la stampa dell'etichetta o della QSL per la quale abbiamo selezionato D nel
buffer di stampa, il contenuto del campo QSLs muta a D e il contatto viene copiato nel registro delle QSL inviate per via diretta. Il tastino a destra del menu a tendina
diviene attivo se si muta lo status QSLs a Y o a D e consente di inserire la data in cui è stata inviata la QSL.
I = non spedisco la QSL (Ignore)
 
Analogamente nel menu a tendina QSLr avremo:
N = QSL non ancora ricevuta
Y = QSL ricevuta via bureau. Il tastino a destra consente di inserire la data in cui si è ricevuta la QSL
D = QSL ricevuta per via diretta. Il tastino a destra consente di inserire la data in cui si è ricevuta la QSL
R = QSL respinta, o ritornataci indietro (not in log, silent key, ecc.)
Questi valori dei campi QSLs e QSLr mutano il colore di fondo della griglia come descritto nella pagina FOGLIO LOG
 
La Sezione e-QSL sovrintende alla gestione delle e-QSL. Settando QSLs = Y il QSO viene inviato al database di eQSL.cc. Quando riceveremo la eQSL potremo riaprire il
QSO con F4 e settare QSLr = Y. E' anche possibile ricevere in automatico il file di conferma da www.eqsl.cc  .
La Sezione SWL si può richiamare da un QSO già registrato con cliccando sulla griglia e poi su F4. Un tasto consente di inserire la conferma per l'SWL che sarà poi
stampata su etichetta o QSL (vedi sezione stampe)
 

 
Se ad esempio abbiamo inserito un call francese e apprendiamo che quell'OM sta attivando un'isola, potremo aprire la sezione IOTA selezionando la linguetta IOTA e
cliccando sul tasto con la "i": si aprirà un database nel quale potremo scegliere la referenza IOT A e importarla nel log con un doppio click sulla riga opportuna. Una volta
importata la referenza IOTA (gruppo), cliccando sul menu a tendina appariranno le diverse isole che fanno parte di quel gruppo e sarà possibile importare anche il nome
dell'isola.  Il programma mostrerà solo i gruppi compatibili con quel call: se il call è francese non si può inserire un'isola italiana. Il T asto  "Island on Google Maps", se si è
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connessi in rete, consente di aprire la pagina relativa alla referenza in questione presso il sito www.rsgbiota.otg con la visualizzazione della mappa della referenza stessa
grazie a Gooogle Maps ™. Le operazioni di accredito vanno eseguite solo sulla griglia che viene prodotta dalla procedura in Award Manager (Award Calculation)
 

 
Cliccando su Managed Awards si aprirà il gestore degli Award, che conterrà tutti gli award relativi a quel callsign. Nell'esempio abbiamo inserito un call polacco: il
programma già ci dice la Gmina per il PGA (OU01 = Olsztyn città), la Provincia per il Polska Award (Warminsko-Mazurskie) e il Powiat per lo SP-PA (Olsztyn) perché ha
trovato queste informazioni nel callbook e le ha estrapolate tramite il database interno. Oppure si può selezionare con un doppio click nella griglia di destra il dato che il
nostro corrispondente ci avrà passato per importarlo nel relativo box. Tutte queste informazioni saranno immagazzinate nel log e saranno consultabili utilizzando il menu
Award Manager nella barra principale dei menu, che vedremo in altra pagina. Per ogni Award gestito il fumetto con la "i" fornisce l'elenco dei codici e la descrizione. Se
una referenza non è presente nel database si può comunque scriverne il codice nalla casella apposita. al prossimo aggiornamento del database (per chi è connesso ad
internet è  automatico) la descrizione di quella referenza sarà aggiunta. Per alcuni database esiste la possibilità per l'utente di aggiungere delle referenze dalla finestra di
visualizzazione (Strumenti -> Visualizza DB Award). Questa opzione è da usare con cautela. Naturalmente solo le finestrelle degli Award relativi a quel Country sono
mostrate. E per Award comuni il database mostrerà solo le referenze relative a quel Country. Esempio: se il call è IK2UVR non stupitevi se non trovate le referenze relative
ai Castelli o alle Abbazie della Sardegna, perché IK2 è ITALY e non SARDINIA. Ovviamente con un call IS0... troverete solo le referenze relative alla Sardegna. Cliccando
su Custom Awards si accede alla Sezione degli Award fai-da-te. Vedi questa pagina.
 
A partire dal 1/1/2012 e fino al 31/12/2012 il form appariva così:
 

 
DXCC Vintage Country mostra il Country come listato nell'elenco dei Countries DXCC del 1937. Ogni contatto potrebbe valere per uno (in qualche caso due) DXCC
Diamond Challenge Country. Alcuni Country di oggi, come SAN MARINO non erano listati nel 1937 qualche altro è differente da oggi, comunque per i dettagli si veda il
sito http://www.arrl.org/diamond-dxcc . Se il call collegato vale per due Countries 1937, (ad esempio Vanuatu vale sia per New Hebrides, british che per New Hebrides,
french in quanto le New Hebrides erano un possedimento anglo-francese e i francesi usavano un prefisso e gli inglesi un altro, un po' come St.Martin oggi: l'isola è una
sola ma conta per 2 Countries) dovrete inserire il QSO due volte, ad un minuto di distanza, uno con un Country 1937 e uno con l'altro perché il programma non può gestire
un doppio dato di questo tipo.
 
Se il Country 1937 può essere determinato dal callsign, il software lo inserirà nel campo appropriato. In qualche caso dovrete inserirlo manualmente perché le scelte sono
più di una, come nel caso del Marocco:
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Come potete vedere il Marocco nel 1937 era diviso in 4 Countries, non determinabili dall'indicativo. In questo modo potrete selezionare quello corretto, anche in un
secondo momento. Per inserire il Vintage Country nei QSO a partire dal 01/01/2012 che sono privi di questo dato, è disponibile una utility in
Strumenti>Configurazione/Manutenzione>AwardAutoChecking>Vintage Countries 1937. Questo è utile sia per i QSO registrati prima di questo aggiornamento che
per log importati come ADIF nel log principale da programmi di contest o simili.
 
Nel caso di log di tipo Expeditioner il form inserimento QSO è dif ferente:
 

 
Come si può vedere, il form è più semplice, non vi sono gli Awards, e c'è un checkbox "Check partial call": se selezionato, compare al di sopra del form un altro riquadro
dove compaiono i nominativi che abbiamo nei nostri log e che corrispondono alle lettere immesse nel campo CALL. Nell'esempio abbiamo inserito le lettere "VB" e nel
riquadro superiore sono apparsi tutti i call registrati nei vari log che abbiamo in archivio che contengono le lettere VB. Basta un doppio click sul call prescelto per importarlo
nel campo CALL del form.
La registrazione del contatto avviene cliccando sul tasto Salva QSO oppure con F12. E' possibile cancellare l'ultimo QSO registrato con CTRL+Canc (o CTRL+Del a
seconda delle tastiere).
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Modifica QSO
 
Posizionandoci su una riga del foglio log la selezioniamo con un click del tasto sinistro del mouse. Il fondo delle caselle diventa blu.
A questo punto cliccando con il tasto destro del mouse avremo due opzioni: MODIFICA QSO (F4) ed ELIMINA QSO.
La funzione MODIFICA QSO apre una finestra simile alla finestra di inserimento QSO:
 

 
Qui possiamo modificare tutti i dati del QSO, per esempio settare a Y o a D il campo QSLr quando riceveremo la QSL per questo
contatto (D = QSL ricevuta per via diretta) e inserire la data di arrivo della QSL. Inoltre si possono gestire le proprie eQSL e
controllare il traffico LoTW. Attenzione: esso viene gestito automaticamente mediante gli invii e le ricezioni dei file dal sito LoTW)
cliccando sulla linguetta LoTW di ogni QSO è possibile vederne lo status ma non è modificabile manualmente. Esiste un sistema più
spiccio per segnare la QSL ricevuta, ed è sulla barra sopra il foglio log: QSLr. DXCC Credit serve per impostare la situazione DXCC
per quel determinato QSO: possiamo scegliere diverse condizioni: NONE se quel QSO non è stato considerato ai fini del Diploma
DXCC, oppure AWARDED se è stato accreditato dal DXCC Desk, oppure REJECTED se è stato respinto, infine APPLIED se ne è
stato richiesto l'accredito.
 

 
Si può utilizzare la funzione RICERCHE (F3) per trovare il QSO desiderato e con un doppio click nella finestra RICERCHE si
seleziona lo stesso QSO anche nella finestra FOGLIO LOG. A questo punto si può utilizzare il tasto QSLr nella barra per mutare lo
stato della QSL ricevuta.
 
Rispetto alla finestra INSERIMENTO QSO questa finestra presenta una particolarità: per ricercare i dati nei callbook (RAC,
Worldcall, Radamato, vedi IMPOSTAZIONI INIZIALI) bisogna usare la combinazione di tasti CTRL+INVIO e non semplicemente
INVIO o TAB. Mentre per la ricerca on-line su www.qrz.com la combinazione è sempre ALT+INVIO.
 
In questa fase possiamo anche gestire le QSL che inviamo agli SWL. Premendo il tasto QSL x SWL si aprirà un box dove potremo
inserire l'indicativo dell'SWL e un eventuale Commento. In questo modo questo QSO verrà  inserito del buffer di stampa delle label
o delle QSL dirette agli SWL
N.B. Queste funzioni non sono disponibili per i log di tipo Expeditioner. Per renderle possibili bisogna riversare un log di tipo
Expeditioner in un log Hunter, il proprio log di stazione oppure un altro log creato alla bisogna. Per il riversamento si può usare
l'IMPORT ADIF oppure il MERGE LOG.
Nella parte inferiore a destra vi sono tre pulsanti per inviare il QSO a Club Log, a EnzoLog e a HRDLog. Questi pulsanti saranno
visibili solo se avremo inserito i relativi dati nelle finestre presenti nella sezione Log Service di Dati User (Log > Modifica Dati User >
nomeuser)
 

https://translate.google.com/
http://www.aribusto.it/BBHelp/ricerche.htm
http://www.aribusto.it/BBHelp/foglio_log.htm
http://www.aribusto.it/BBHelp/inserimento_qso.htm
http://www.aribusto.it/BBHelp/impostazioni_iniziali.htm
http://www.qrz.com/
http://www.aribusto.it/BBHelp/IndexBBH.htm
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Ricerche nel log
 
Mediante il tasto RICERCHE (F3) è possibile fare ricerche nel log utilizzando chiavi di ricerca a piacere.

 

 
Ad esempio si possono ricercare tutti i contatti avuti con un certo call, oppure per QTH, per data, eccetera. Si possono fare diversi
tipi di ricerche: ad esempio se immettiamo nel box K1BV, con campo di ricerca selezionato CALLSIGN, e radius selezionato "="
avremo l'elenco di tutti i QSO con la stazione K1BV. Se invece selezioniamo il radius "$" otterremo tutti i QSO con stazioni che
INIZIANO con K1BV, quindi anche K1BVX o K1BV/8, eccetera. Il radius "<>" consente di estrapolare i QSO con stazioni che
CONTENGONO la stringa K1BV, quindi troveremo ad esempio anche IK1BVZ, OK1BVW, JK1BV, ecc.  Selezionando i vari Award si
potranno visualizzare i contenuti dei rispettivi campi e si possono fare ricerche anche per referenza selezionando l'Award e
immettendo la referenza usando come campo di ricerca AWARD REF. A destra si possono selezionare i log nei quali effettuare la
ricerca.
 

 
Usando come criterio di ricerca la data possiamo utilizzare gli operatori booleani >= (maggiore o uguale) e <= (minore o uguale):
inserendo ad esempio 01/01/1995 e 31/01/1995 possiamo estrapolare tutti i QSO del gennaio 1995:
 

https://translate.google.com/


 
I QSO elencati sono editabili con la procedura: click con tasto sinistro - click con tasto destro - edit (o F4) esattamente come nel
foglio log. Vedi MODIFICA QSO. Cliccando sull'icona di EXCEL in alto a destra nel riquadro si potrà esportare il risultato della
ricerca come foglio di Excel.
 

http://www.aribusto.it/BBHelp/modifica_qso.htm
http://www.aribusto.it/BBHelp/IndexBBH.htm
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Terminale Packet Cluster
 

 
Questo è il terminale Packet Cluster. Consta di diverse finestre e diverse modalità: qui sopra vediamo la modalità CLUSTER  MONITOR selezionata nella barra inferiore:
abbiamo la finestra di traffico e la finestra-interfaccia comandi per dialogare con il sistema remoto.  I pulsanti nella barra menu Packet Cluster in alto sono abbastanza
intuitivi. I pulsanti nella colonna di destra sono editabili dalla sezione Setup. Il font e la sua dimensione sono selezionabili cliccando con il tasto destro del mouse nella
finestra di traffico o nella finestra-interfaccia comandi. Si aprirà questa finestra di selezione in cui potremo scegliere le caratteristiche desiderate:
 

 
Prima di tutto però  dovremo eseguire i settaggi, premendo la linguetta SETUP nella parte inferiore della finestra. Compare il box illustrato qui sopra da cui si possono
selezionare tipo di carattere, stile, dimensione ed effetti.
 

 
Innanzitutto nella sezione GENERAL dovremo scegliere il mezzo che abbiamo a disposizione nel nostro shack: Radio Cluster se intendiamo connetterci ad un sistema
via etere-TNC oppure Telnet Cluster se siamo connessi a Internet. La terza opzione, Cw Skimmer, consente di trasformare la finestra del Packet Cluster in un Terminale
Cw Skimmer se abbiamo questo programma nel computer (http://www.dxatlas.com/CwSkimmer/) .  Con Rx Font Color definiremo il colore del carattere nella finestra di
traffico e con Rx Background Color sceglieremo il colore dello sfondo. A sinistra c'è la griglia per editare i pulsanti di richiesta al Cluster. Si raccomanda di fare attenzione
alla sintassi che è dif ferente per ogni tipo di Cluster.
 

https://translate.google.com/
http://www.dxatlas.com/CwSkimmer/


 
Premendo la linguetta TELNET potremo selezionare il nodo Telnet cui connetterci. Il programma assume in automatico il Callsign dell' USER (oppure quello specificato in
sede di definizione del nodo nel campo NODE LOGIN) e con esso si connette al Cluster desiderato. E' possibile inserire anche una eventuale PASSWORD per ogni Nodo
Telnet o in fase di registrazione del nodo (AGGIUNGI NODO) o editando un nodo preesistente (MODIFICA NODO). I nodi obsoleti possono essere cancellati con
CANCELLA NODO. Il link Internet Telnet Link vi porta ad una pagina web che contiene un elenco molto corposo di nodi Telnet con tutte le specifiche per i settaggi.
Questi sono i settaggi dei Nodi:
 

 
Si possono inserire tutti i dati del Nodo, eventuale Password, e scegliere il tipo di Nodo tra DXSPIDER, DXNET e ARCLUSTER
 

 
Premendo la linguetta RADIO potremo settare i parametri in caso di connessione via etere al Packet Cluster: ComPort indica ovviamente la porta seriale al quale il
sistema è connesso, Speed è la velocità di trasferimento dati tra il computer e la radio (in genere 9600 ma possono esserci delle eccezioni), TNC Type consente di
selezionare i parametri preimpostati per un certo numero di TNC, e con Handshake si può settare il protocollo, se dovesse rivelarsi necessario (Nessuno, XON/XOFF, 
RTS oppure XON/XOFF/RTS). In genere facendo qualche prova si riesce a configurare il proprio TNC abbastanza agevolmente. Anche in questo caso vi sono i pulsanti
per aggiungere, cancellare ed editare i nodi, Nodes Radio è un menu a discesa che mostra e consente di selezionare il nodo cui vogliamo connetterci e Set TNC Radio è
un pulsante che seleziona il modo Radio Cluster, analogamente a quanto avviene nella sezione GENERAL. La finestra centrale TNC Commands mostra i comandi di
settaggio che vengono inviati al TNC e sono funzione della scelta effettuata con TNC Type.
 



 
La linguetta FILTERS consente di impostare i filtri sugli spot a seconda di quello che ci interessa evidenziare: Filter Band consente di selezionare la bande di interesse e
Filter Mode i modi. Only DX spotted from consente di selezionare i continenti dai quali giungono gli spot, escludendo ad esempio quelli i cui spot non possono esserci
utili. Queste selezioni avranno solo valore per la finestra dello spot. Nella finestra principale transiteranno sempre e comunque tutti gli spot. Con Selected Callsigns si
possono inserire i Call da "tenere d'occhio": quando verranno spottati quei determinati call un Alert color MAGENTA comincerà a lampeggiare nella barra superiore e una
striscia di colore ROSSO apparirà nella Finestra dello Spot (doppio click per cancellarla). Lo stesso in Selected Comments: se teniamo d'occhio una certa spedizione
IOTA, potremo inserire la referenza, e quando verrà  segnalata comparirà egualmente l'Alert lampeggiante. (Naturalmente deve essere esatta la sintassi: se scriviamo AN-
001 e viene spottato AN001 non sarà riconosciuto)
 

 
La linguetta BANDS consente di avere la visualizzazione degli spot selezionati per banda. I pulsanti coincidono con le bande che avremo selezionato in FILTER BANDS
del SETUP (funzione disponibile dalla release 1.0.2.7 / 001). Un doppio click sulla griglia apre la finestra Dati QSO (F2) e importa i dati. Funzione disponibile se Spot >
QSO è selezionato in Setup > Alerts (vedi immagine sottostante).
 

 
La sezione ALERTS/OPTIONS consente di selezionare tutto quanto riguarda quegli spot che ci interessano: Icon Spot fa comparire un fumetto contenente tutti i dati dello
spot nei pressi del Tray (angolo inferiore destro dello schermo). E' utile se abbiamo aperto in primo piano degli altri programmi perché questo fumetto ha priorità di
visualizzazione e compare sempre al di sopra ogni finestra che abbiamo aperto. Speech Spot fa parlare il computer: quando arriva uno spot, il computer reciterà il call con
voce femminile utilizzando l'alfabeto fonetico ICAO (alfa, bravo, charlie delta, echo...). Se non vogliamo lo spot recitato è sufficiente selezionare Sound Spot invece di
Speech Spot: ogni volta che arriva uno spot verrà emesso solo un segnale sonoro. Spot Marker consente di variare il colore dei caratteri degli spot che soddisfano le
condizioni che abbiamo impostato nella finestra SETUP>FILTERS, con il tasto Spot Marker Color si può selezionarne il colore. Set alternativi di voci sono scaricabili dal
sito di BBLogger: www.bblogger.eu . Il box Spot>QSO se spuntato fa sì che un doppio click sulla finestra di spot o sulla griglia apra la finestra inserimento QSO (F2) e vi
trasporti lo spot. Infine Check Calls e Check Remarks se spuntati consentono di fare apparire gli Alert quando compariranno i Call selezionati oppure i Comment
selezionati in SETUP>FILTERS. New One Filter consente di fare apparire solo i New Ones, Check LoTW abilita la visione della colonna LoTW nella griglia Filtered
Spots e Auto Connect consente di connettersi immediatamente al Cluster selezionato all'apertura del programma. Spot Log On File consente di realizzare un diario-
giornale degli spot ricevuti in formato testo. Spot scroll-lock blocca lo scorrimento degli spot se ci posizioniamo su uno di essi col mouse e Note Cluster > Comment se
selezionato importa nel campo comment di BBLogger le note che compaiono assieme allo spot (ok, a volte non servono a nulla). Min Rows Spots quantifica il numero di
spot che compariranno prima che l'Auto Clear entri in azione. Preamble carica un certo numero di spot passati prima del login nella griglia di Filtered Spots e di Bands. Il
numero di questi spot può essere scelto con il menu a tendina (da 25 a 500 spot). New One DXCC, New One Cq Wpx e New One Cq Zone abilitano/disabilitano i
messaggi colorati che compaiono nelle varie occasioni.
 

http://www.bblogger.eu/


 
Selezionando FILTERED SPOTS compare la griglia qui sopra che comprende gli spot che soddisfano le condizioni che abbiamo impostato. I colori di fondo delle caselle
consentono di sapere la propria situazione nei confornti di quel Country o di quel Prefisso (per il WPX) o di quella Zona CQ (per il WAZ). Lo stesso codice colorato
compare accanto al simbolo arancione del feed in alto a destra: questo è il significato dei colori: GIALLO indica un NEW ONE DXCC nella banda specificata, ARANCIO
indica un NEW ONE DXCC nella banda specificata GIA' COLLEGATO MA NON CONFERMATO (indica anche l'anno in cui è avvenuto il contatto), ROSSO indica un
NEW ONE DXCC ASSOLUTO , VERDE indica un NEW PREFIX in quella banda e AZZURRO un NEW PREFIX ASSOLUTO. VERDE CHIARO indica un NEW ZONE in
quella banda e BLU CHIARO un New Zone assoluto. Un DOPPIO CLICK sulla griglia trasferisce tutti i dati relativi a quello spot (call, banda,  modo e note) nella finestra di
inserimento QSO se è stato selezionata la casella Spot>QSO in SETUP>ALERTS . Selezionando una riga e poi premendo F7 avremo la situazione DXCC di quel Country
(vedi ultima immagine). Le colonne S.P. e L.P. ci forniscono il puntamento dell'antenna (Short Path e Long Path), la colonna LoTW ci dice se qual particolare Call è iscritto
al programma LoTW  (nell'esempio A65EE) e nella colonna Informations sono mostrate le informazioni comparse nel riquadro colorato.
 

 
La finestra MON RQ è la destinazione delle nostre richieste al Cluster effettuate tramite il pulsante sulla barra superiore. In questo modo non subiranno lo scroll dovuto
all'arrivo di nuovi spot. Comunque l'output viene diretto anche nella finestra Cluster Monitor.
 

 
La linguetta WWV fa comparire questa finestra (sopra) che ci fornisce varie informazioni sulle condizioni del sole, si possono elencare gli ultimi 10 oppure 100 spot con
visualizzazione tipo WWV oppure WCY.
 



 
SATELLITE consente di avere i dati kepleriani dei satelliti amatoriali selezionando il satellite dal menu a discesa sottostante.
 

 
GREYLINE fa comparire questa schermata (sopra) con la greyline ed altre informazioni.
 

 
PROPAGATION fa comparire la schermata (sopra) con i dati relativi alle condizioni del sole e di propagazione nelle varie bande.
 

 
La linguetta MESSAGE introduce la sezione dedicata alla messaggeria del Cluster. Nella schermata sopra vediamo il riassunto dei messaggi che si ottiene premendo DIR.
DIR/100 fa comparire gli ultimi 100 messaggi, DIR/BULL fa comparire l'elenco degli ultimi bollettini, DIR/NEW fa comparire l'elenco dei messaggi di tipo NEWS e
DIR/OWN fa comparire l'elenco dei messaggi a noi indirizzati. Ogni messaggio si può leggere selezionandolo con il mouse (la riga diventa blu) e con il tasto destro del
mouse selezionando READ MESSAGE. Si aprirà la finestra MESSAGE e comparirà il testo del messaggio selezionato. Con PrintView Msg si produce un'anteprima di
stampa del messaggio selezionato che può venire stampato. I messaggi diretti a noi oltre che essere letti possono essere cancellati mediante il comando Delete Message
dal tasto destro del Mouse. Messaggi altrui non possono venire cancellati.
 



 
SEND MESSAGE consente di inviare un messaggio a un utente (inserendo il call nella finestra To) in forma Privata (spunta su Private) oppure a tutti: ALL in forma
pubblica. In Subject si mette il titolo e nella finestra il testo del messaggio.
 

 
Con TALK si possono inviare e ricevere dei talk, cioè dei brevi messaggi, come in una chat. In Call to send si inserisce il Call dell'utente cui si vuole inviare il talk, ed
eventualmente il Nodo Packet Cluster se l'utente non è collegato al nostro stesso nodo. Nella finestra sottostante si scrive il messaggio breve e con Enter si inoltra. La
finestra più grande con sfondo celeste mostrerà il traf fico dei talk ricevuti.
 

 
Con CALL INFO si possono avere informazioni relative a Call che si sono collegati alla rete Cluster. Utile per conoscere l'Home Node per indirizzare eventuali Talk.
 

 
La linguetta ANN introduce il gestore degli ANNOUNCE. Nella finestra List Announces compaiono i vari Announce passati. I comandi a sinistra consentono di
selezionare quanti Announce visualizzare.



 

 
Se vogliamo inviare un ANNOUNCE possiamo farlo con la Sezione New Announce: I due radius consentono di selezionare la destinazione del nostro Announce: Local
Cluster è quello cui noi siamo connessi, e quindi spuntando questa opzione l'Announce viene trasmesso solo coloro i quali sono connessi al nostro nodo, mentre con
l'opzione To All Nodes Clusters lo inviaremo a tutti i cluster connessi in rete. Il testo del messaggio-announce va scrtitto nella finestra sottostante e con SEND
ANNOUNCE viene inviato.
 
Nella FINESTRA DI SPOT compaiono solo gli spot che rispondono ai criteri selezionati mediante i filtri che abbiamo visto nella sezione SETTINGS. Un DOPPIO CLICK sul
call che compare in ROSSO nella finestra di spot trasferisce tutti i dati (call, banda, modo e note) nella finestra di inserimento QSO. La striscia al di sotto del Country DXCC
visualizza il QRB e il puntamento dell'antenna via corta o via lunga. Al di sotto edi essa compare la nostra situazione nei confronti di quel Country DXCC in quella banda
nei vari modi. Il codice colore è il seguente: BIANCO = non lavorato, ROSSO = lavorato, VERDE = confermato, GIALLO = confermato via LoTW, AZZURRO = accreditato
dal DXCC Desk.
 

 
Inoltre con il tasto F6 possiamo far comparire la nostra situazione nei confronti di quel Country (ultimo spot) nelle varie bande e nei vari modi. Ricordiamo che con F7
compare invece la situazione del Country che avremo evidenziato sulla griglia. Per semplicità abbiamo ridotto i modi a sei (SSB, CW, RTTY, PSK, SSTV e FM) più OTHER
per tutti gli altri modi diversi da questi sei:
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La Barra dei Comandi
 

 
La Barra dei Comandi contiene i menu FILE, LOG, STRUMENTI, STAMPE, AWARDS MANAGER, CUSTOM AWARDS e INFO
 
Il menu FILE apre il FILES MANAGER che consente le operazioni sui files in formato ADIF (funzioni di editing sui log). Attivando il
programma per la prima volta e avendo usato un altro software in precedenza dovremo importare il nostro log dal vecchio al nuovo
programma. Diamo per scontato che abbiamo già creato il nostro log di BBLogger e che abbiamo esportato dal vecchio software il
log in formato ADIF. A questo punto potremo importarlo in BBLogger selezionando l'opzione VERIFICA AUTOMATICA DXCC. Se
nel file ADIF è presente il codice numerico DXCC i QSO verranno importati con quel Country senza altri controlli (e quindi potrebbero
essere importati errori) Se invece non è presente il codice DXCC la routine importerà i QSO con Country DXCC certo, sulla base del
database DXCC interno, mentre scriverà un secondo file ADIF contenente i QSO con Country dubbio (esempio GB, VP8, ZK1, ecc.)
In un secondo momento potremo importare questo secondo file settando però l'opzione VERIFICA MANUALE DXCC. In questo
modo potremo assegnare il corretto Country ai nostri QSO. Questa funzione di importazione è utile anche nel caso avessimo creato
un log per un'attivazione e poi desiderassimo importarlo nel nostro log principale, accodando i QSO. Lo possiamo fare esportando il
file dell'attivazione con la funzione ESPORTA LOG IN ADIF e importandolo successivamente nel nostro log principale con la
funzione IMPORTA FILE ADIF. Il programma chiederà le informazioni relative al log e procederà all'importazione. 
 

 
La funzione ESPORTA LOG IN FILE consente appunto di esportare un log in formato ADIF.  Anche in questo caso possiamo
selezionare un intervallo di date e possiamo anche copiare il contenuto di svariati campi legati ai diplomi gestiti nel campo comment,
per utilizzi diversi con altri programmi di log. La funzione DOWNLOAD FILE LOTW/EQSL è stata pensata per importare i credit files
da LoTW e da eQSL.cc. e dal programma DM780.
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LoTW/eQSL/DM780/QRZ.com è la sezione per stabilire i collegamenti con questi programmi e servizi:
 

 
Il menu LOG consente di AGGIUNGERE UN NUOVO OM per esempio se ad utilizzare il programma di log sono due OM oppure
anche per aggiungere un altro call posseduto (call speciali, call da contest ecc.), MODIFICARE I DATI DI UN OM, (vedi AVVIO
PROGRAMMA), CREARE NUOVI LOG, APRIRLI, MODIFICARLI, ELIMINARLI, e CREARE DEI LOG FILTRANDONE UN ALTRO:
ad esempio potremmo voler estrapolare dal nostro log tutti i contatti effettuati durante un periodo di tempo determinato, oppure tutti i
contatti con un determinato nominativo, o altro ancora. Per questo occorre prima selezionare il LOG ORIGINE tra quelli presenti e
poi individuare i FILTRI da applicare:
 

 
Si deve scegliere il campo da filtrare, il tipo di filtro e inserire inserire un valore nel box di destra. Ad esempio possiamo selezionare
CALLSIGN = IK2UVR e selezionare un intervallo di data, esempio 06/08/2008 - 06/09/2009 per creare un nuovo log filtrato che
contenga solo i QSO avuti con IK2UVR nell'intervallo di tempo specificato. Anche in questo caso possiamo usare la wild card $
(segno di Dollaro) per ottenere anche i call che contengono la stringa desiderata, come i call barrati (IK2UVR/IS0, F/IK2UVR,
eccetera).

http://www.aribusto.it/BBHelp/avvio.htm


L'ultima voce è MERGE LOG/LOG che consente di unire due log, selezionando il log ORIGINE e il log DESTINAZIONE tra quelli
presenti. Vi è anche un'opzione ELIMINA LOG ORIGINE nel caso appunto volessimo cancellare il log dopo averlo aggiunto al log
destinazione.
 
Il menu STRUMENTI contiene le voci CONFIGURAZIONE/MANUTENZIONE (vedi pagina  Impostazioni), QSL MANAGER (vedi
pagina QSL Manager ), MANAGER per la gestione del database Manager :

 

 
Si possono fare ricerche per call e per manager. Il database è aggiornabile dall'utente:
 

 
Le altre voce del menu STRUMENTI sono delle utility: DXCC mostra il contenuto del database DXCC. Si può filtrare per Country.
 

 
PROPAGAZIONE ON-LINE è un'utility del menu STRUMENTI che apre una finestra browser in cui vengono fornite predizioni sulla
propagazione, in base alle condizioni di flusso solare del momento. E' necessaria la connessione Internet. Per chiudere il browser
cliccare sulla X nell'angolo superiore destro della finestra.
 

http://www.aribusto.it/BBHelp/impostazioni_iniziali.htm
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APRS ON LINE è un'utility del menu STRUMENTI che apre una finestra browser con le indicazioni APRS delle stazioni operative in
quella zona. Per chiudere la finestra premere sulla X nell'angolo superiore destro della finestra stessa.
 

 
E' possibile centrarla su una città o un Locator mediante il menu funzioni presente a destra nella finestra:
 



 
HAM MAPS è un'utility del menu STRUMENTI che, come dice il nome, fornisce svariate mappe radioamatoriali, con Countries,.
zone CQ, zone ITU,  Locator.
 

 
AWARD DATA VIEWER è una utility del menu STRUMENTI che consente di visualizzare, ricercare, e in qualche caso modificare ed
aggiungere i dati contenuti nei vari database relativi agli Award implementati.
 



 
QSL MANAGEMENT è una importante utility del menu STRUMENTI che ci consente di tenere sott'occhio la situazione delle QSL .
Si veda la pagina QSL Manager
Le altre voci consentono di attivare il  BB Terminal e di attivare BBLCAT con i quali BBLogger può interfacciare Omnirig by Alex
VE3NEA,  e i programmi di CAT di Mauro IZ2BKT. Questi ultimi sono scaricabili dal sito www.iz2bkt.com . Questi sono programmi
indipendenti e opzionali, che si interfacciano con BBLogger tramite BBLCAT ma non sono essenziali per il suo funzionamento.
Il menu INFO contiene: l'icona Help (F1) che verifica la connessione internet e se presente lancia il presente HELP-ON-LINE,
altrimenti lancia l'help presente a corredo del programma su Hard Disk, e Controllare gli aggiornamenti: che consente di
controllare se i nostri database sono aggiornati. In genere il controllo avviene in automatico se si è connessi alla rete.
Gli altri menu della Barra comandi sono Stampe , Awards Manager e Custom Awards, per i quali si rimanda alle relative pagine.
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Stampe
 
Questo menu consente di effettuare vari tipi di stampe:
 
STAMPA LOG:
Questa sezione consente di fare stampe a piacere del proprio Log. E' possibile stampare su file tipo testo (TXT) oppure in HTML,
apribile da qualsiasi browser, Explorer, Firefox, ecc, oppure in Excel (Microsoft) / Calc (Sun). Si possono inoltre selezionare i campi
da includere nella stampa:
 

 
Spuntando la casella Filtro Date si può impostare un intervallo di data, spuntando i vari diplomi gestiti si possono aggiungere alla
stampa le informazioni contenute nelle relative aree dedicate. Con Date Ascending il log viene stampato dal QSO più vecchio al più
recente. Naturalmente i criteri possono essere combinati fra loro. I due pulsanti in basso selezionano la stampa Excel, HTML o TXT.
Con Book Station si stampa un log analogo a quelli che si trovano in commercio, e con Start nr. si può definire l'inizio della
numerazione dei QSO. Questo tipo di log soddisfa tutte le esigenze di legge per il Log di Stazione da conservare nella propria
Stazione Radio ed esibire ad ogni eventuale controllo delle autorità. Il checkbox SUM QRB consente di avere una somma dei QRB
utile talvolta in certe bande.
 
Questo è un esempio di log HTML:
 

 
E questo è un esempio di log TXT. La stampa in TXT non è customizzabile.
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STAMPA LABEL E QSL:
In questa sezione vedremo come stampare le etichette con i dati del QSO o addirittura le QSL.
Innanzitutto dobbiamo selezionare i QSO per i quali vogliamo stampare l'etichetta. Tutti i QSO il cui campo QSLs contiene "N"
vengono copiati nel buffer di stampa. Selezionando dal menu STAMPE la voce STAMPA ETICHETTE QSL si aprirà una finestra
come questa:
 

 
In questo box possiamo selezionare manualmente i QSO per i quali stamperemo l'etichetta, oppure premendo il tasto SELEZIONA
TUTTO abiliteremo tutti i QSO contenuti alla stampa. Potremo altresì decidere di stampare le etichette o le QSL relative ai QSO di
uno o di più log, spuntando le caselle nel campo ORIGINE DEL LOG. Con COUNTRIES FILTER potremo visualizzare tutti i QSO da
stampare (NONE) oppure solo quelli con un determinato Country. Cliccando su ORIGINE DEL LOG si selezionano/deselezionano
tutti i log presenti. Il numero dei QSO viene evidenziato in colore rosso. L'ultima colonna a destra consente di selezionare le etichette
o le QSL che vogliamo inviare per via diretta. Le righe sono settate di default a Y (invia QSL via bureau) ma possono essere settate
manualmente a D (invia QSL via diretta) mediante una casella menu a discesa posta all'estrema destra di ogni riga. Le colonne sono
ordinabili in senso A-Z o Z-A. E' disponibile anche una colonna Bureau che consente di ordinare le proprie stampe di cartoline QSL
per Bureau di destinazione. nel caso vi sia il manager il programma inserisce queste QSL o etichette ordinando per Bureau del
manager. Le QSL per SWL non seguono questo ordine (dato che ad esempio gli SWL dei Paesi Bassi hanno codice NL0000, e le
QSL verrebbero quindi poste in un Bureau degli U.S.A.) Una volta effettuate le selezioni, cliccheremo sulla linguetta STAMPA
ETICHETTE oppure QSL TEMPLATE se stiamo usando la STAMPA QSL:
 



 
Questo box è la "Centrale di Stampa" delle nostre labels: qui possiamo impostare tutti i parametri di stampa: dimensioni delle
etichette con i box di colore verde, numero di righe e colonne con i box di colore giallo, e le distanze tra le varie etichette e i bordi del
foglio con i box di colore bianco. In basso a destra c'è l'etichetta come la vedremo, i vari elementi sono gestibili a piacere.
Selezionando un elemento (lo sfondo diventa giallo) questo potrà essere spostato con il mouse oppure mediante le coordinate X e Y.
La dimensione preimpostata del foglio da stampare è A4, ovvero 297 mm x 210 mm, ma questi parametri si possono variare in
presenza di altri formati. Nell'esempio abbiamo un foglio che contiene 16 etichette (2 colonne e 8 righe) ma possiamo settare i valori
che vogliamo. Ad esempio se avessimo dei moduli per stampante a trattore e volessimo usarli con una stampante inkjet, divideremo
i moduli lungo le linee di taglio ottenendo delle "pagine" con una sola colonna e 8 etichette. Faremo qualche prova con le distanze
fino a trovare i valori che ci consentono una stampa ottimale e poi salveremo il nostro modello con il tasto SALVA MODELLO per
poterlo utilizzare in seguito. Le opzioni Etichetta consentono di selezionare le dimensioni della singola etichetta. La barra con sfondo
rosa mostrerà il nome che avremo dato alla nostra etichetta. I singoli elementi contenuti nell'etichetta sono riposizionabili con il
mouse o i tasti freccia (le coordinate X e Y servono per l'allineamento orizzontale e verticale degli elementi). Per fare questo cliccare
con il tasto sinistro del mouse sull'angolo superiore sinistro dell'elemento per selezionarlo. Se si clicca con il tasto destro del mouse
si apre un menu che contiene le voci FONT per selezionare font, dimensioni, stile e colore, e ELIMINA per cancellare l'elemento.
Attenzione: se si ridimensiona l'etichetta riducendone le dimensioni bisogna prima eliminare gli elementi dei vari QSO,
lasciando solo quelli che l'etichetta nelle nuove dimensioni può contenere. Se si lasciano gli elementi e si riduce il formato
dell'etichetta risulteranno non stampati dei QSO con la stessa stazione (nel caso di QSO plurimi) che invece il programma considera
stampati in quanto sono presenti i tag relativi, anche se nascosti. Con il tasto CARICA MODELLO caricheremo uno dei modelli che
avremo salvato, e con il tasto blu IMPOSTA STAMPANTE potremo aprire il menu della stampante. Con il tasto BACKGROUND
IMAGE è possibile caricare un'immagine di sfondo. Si possono creare etichette con un massimo di 6 QSO. Il box Economy Sheet
serve per ottimizzare le stampe: ad esempio se impostiamo un numero di label per foglio = 24 e le etichette da stampare sono 26, il
programma non stampa le ultime 2 etichette. Se invece il box non viene selezionato il programma userà due fogli A4, di cui uno sarà
utilizzato solo parzialmente per stampare due sole etichette. I box sulla destra: BORDI ETICHETTA produce una stampa con i bordi,
utile ad esempio se non abbiamo fogli di etichette fustellate ma fogli unici adesivi: stampando i bordi possiamo tagliare le diverse
etichette con una taglierina; RAGGRUPPA CALL consente di raggruppare i QSO effettuati con quel call e quindi di stampare
etichette con QSO plurimi; STAMPA COMMENT inserisce nell'etichetta il contenuto del campo comment: ad esempio se effettuiamo
una spedizione per attivare un castello, o un'abbazia, o un lago, o un'isola, il programma inserisce la referenza nel campo comment,
e quindi selezionando questo box ogni etichetta riporterà le informazioni che desideriamo fornire ai nostri corrispondenti. Con FONT
SIZE e INTERLINE si può aumentare/diminuire la dimensione dei caratteri e lo spazio tra le linee. Se viene selezionato Raggruppa
Call, è possibile stampare i QSO in ordine di data ascendente (ASC) o discendente (DESC). Potete cambiare il colore e il font di
tutti gli elementi presenti nell'etichetta selezionandoli e cliccando col tasto destro del mouse. Con il tasto STAMPA/ANTEPRIMA si
accede all'anteprima della nostra stampa:
 



 
Se tutto ci soddisfa possiamo cliccare sull'icona con la stampante, in alto a sinistra, e stampare le nostre etichette. Dopo la stampa
comparirà un riquadro che ci chiede se vogliamo aggiornare il log. Selezionando SI lo status QSLs di quei QSO muta da "N" a "Y"
oppure a "D" se avremo deciso di inviare la QSL per via diretta, e il relativo QSO sarà copiato nel Registro QSL dirette con la data
in cui è stata ef fettuata la stampa.
Anche nel box QSL BUFFER le colonne possono essere ordinate alfabeticamente, quindi ordinando per CALL avremo una stampa
di etichette ordinate per CALL. Nelle prossime versioni il contenuto delle etichette sarà in parte editabile dall'utente.
Il menu STAMPA QSL consente di selezionare se vogliamo tampare le QSL per i nostri contatti (OM > OM) oppure per gli SWL (OM
> SWL). La prima opzione apre una finestra analoga a quella già vista in cui si devono selezionare dal buffer i QSO da stampare su
QSL. Anche in questo caso possiamo cambiare a piacere le opzioni di invio delle QSL (via Bureau o Via Diretta). QSL TEMPLATE
apre questa finestra:
 

 
In questa finestra possiamo editare la nostra QSL base o creare vari modelli da salvare e utilizzare per i vari scopi. I box sono
riposizionabili e l'illustrazione può essere sostituita con una immagine a piacimento. Nella barra c'è un asterisco (*) che può essere
sostituito da un testo a piacere e costituisce il contenuto del campo comment, che possiamo stampare spuntando la casellina
STAMPA COMMENT. La casellina RAGGRUPPA CALL serve per raggruppare diversi QSO effettuati con il medesimo call sulla
stessa QSL. QSO Date Multi serve per selezionare l'ordine dei QSO (dal più vecchio al più recente o viceversa), e la casellina
CARICAMENTO VERTICALE consente di stampare le QSL con il lato più corto verso la stampa, "Japan style". Si possono
stampare fino a 8 QSO per ogni QSL orizzontale e 8 QSO + 8 righe di Comment per ogni QSL "Japan". La casella Pse/Tnx QSL
assume i dati dallo status del campo QSL ricevuta, e muta di conseguenza: se QSLr = "N" scriverà Pse QSL altrimenti scriverà Tnx
QSL. Sotto questa casella c'è un'altra immagine <SIGN HERE> sostituibile con una firma scannerizzata, o da una seconda
immagine a piacere. IMPORTANTE:  a partire dalla versione 1.0.2.0 sono state cambiate le impostazioni dei template, sie per
le QSL che per le etichette, quindi se quelli che avete salvato non producono risultati ottimali, eliminateli e rifateli a partire
da quelli di default, modificandoli a vostro piacimento e salvandoli.



 
OM > SWL apre una finestra del tutto simile a quella vista per la stampa etichette. Selezioniamo i contatti per cui intendiamo spedire
la QSL all'SWL spuntando le caselline (o usando il tasto Seleziona Tutto) e poi premiamo la linguetta del Template. Come nel caso
delle QSL per OM, possiamo editare a piacere la nostra QSL per SWL, salvare le modifiche e caricare i modelli salvati. La differenza
rispetto alla QSL per OM è che non c'è il rapporto ed è presente la voce WORKED per indicare la stazione con cui il QSO venne
effettuato e per cui il rapporto HRD è stato richiesto dall'SWL. Anche in questo caso si può scegliere tra QSL orizzontale e verticale
con il tasto R.
 
QSL CUSTOM permette di stampare QSL con il retro prestampato, posizionando tutti gli elementi del QSL nella posizione
desiderata:
 

 
Scannerizzate il retro della vostra QSL e caricatelo con il pulsante BACKGROUND IMAGE, poi scegliete gli elementi da porre sulla
QSL con un doppio click nell'elenco di sinistra: l'elemento selezionato comparirà nell'angolo superiore sinistro della QSL.
Attenzione: i tag DD_MM_YY_UTC e DD_MM_YYYY_UTC posizionano semplicemente una scritta "DD MM YY UTC" e DD MM
YYYY UTC" come riga di intestazione, e non i valori di questi elementi che devono essere inseriti con i tag appropriati: DD, MM, YY
o YYYY e UTC Con il tasto destro del mouse si può scegliere il font e la sua dimensione per quell'elemento, e anche eliminarlo,
mentre con il tasto sinistro è possibile posizionarlo nella maschera. Le due finestrelle X e Y aiuteranno ad allineare gli elementi: X
rileva il movimento orizzontale e Y quello verticale dell'elemento mediante un valore numerico. E' anche possibile inserire un disegno
e un'altra immagine, per esempio una firma scannerizzata. Si noti che si può inserire la Banda oppure la Frequenza, dato che molte
QSL prestampate riportano la Frequenza invece della Banda. Logicamente sarà una Frequenza di massima, non precisa, es. 40m =
7 MHz, 15m = 21 MHz, 6m = 50 MHz, ecc. Logicamente ogni QSL Custom realizzata può essere salvata e riutilizzata. Cliccando di
nuovo su Background Image essa sparirà e la QSL potrà essere stampata con i soli elementi del QSO. Naturalmente si può
stampare anche l'immagine di sfondo se si desidera farlo, ad esempio su una QSL con retro bianco. L'immagine di background
serve per il posizionamento degli elementi, di solito non viene memorizzata, se invece si seleziona Image background essa sarà
salvata assieme alla QSL custom.
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Awards Manager
 
Questa sezione gestisce i Diplomi che avremo scelto di seguire. Selezionando quindi l'opzione VISUALIZZA AWARD si aprirà la "Centrale di
Comando" dei nostri Awards. Le opzioni sono 7: DXCC AWARDS, CQ AWARDS, CASTLES/ABBEYS AWARDS, ISLAND AWARDS, FLORA
FAUNA AWARDS, OTHER AWARDS e TOPLIST & STATISTICS. La sezione DXCC AWARDS gestisce gli award legati al DXCC, nelle suoi
diversi endorsements, :
 

 
Tramite il menu a discesa potremo selezionare l'Award che ci interessa. Nell'esempio qui sopra è selezionato il DXCC MIXED.
A questo punto selezioneremo le bande, i modi ed eventualmente anche i Continenti, per quanto riguarda gli Award continentali come ad
esempio lo IOTA EU, lo IOTA NA, ecc. Cliccando sull'etichetta (Bands, Classic Modes, Digital Modes) si possono selezionare / deselezionare in
blocco tutte le voci.
Attenzione: queste selezioni devono essere fatte in accordo con i regolamenti dei vari Awards. E' compito dell'utente informarsi
riguardo alle regole nonché ai modi e alle bande valide per quel determinato Award. Questa sezione del programma è intesa solo a
fornire un aiuto all'utente per la redazione della richiesta dell'Award, che in certi casi deve essere effettuata su moduli ufficiali rilasciati
dal Manager del Diploma e con modalità differenti da quelle presentate. Gli autori pertanto non si assumono alcuna responsabilità
relativamente a richieste rifiutate dal Manager perché non conformi al regolamento dell'Award stesso. A questo scopo è presente una
sezione informativa "Application Informations" (vedi ultima immagine).
Il box "Visualizza bandiere DXCC" fa comparire accanto al nome del Country la relativa bandierina. Dato che per caricare il set di bandiere
occorre del tempo, se questo dovesse rallentare troppo la visualizzazione si può ovviare al problema deselezionando la casella. A titolo
indicativo, con processori moderni tipo Dual Core questo tempo varia dai 10" ai 15". Il box "eQSL valid for this Award" se spuntato considera
valide anche le eQSL (dipende dai vari Award se esse siano ritenute valide o meno). Il box "Count Deleted Entities" mostra le entità DXCC
cancellate e le conteggia in caso il QSO sia stato effettuato quando esse erano ancora attive. Il Filtro di Data consente di inserire un intervallo di
date per quei Diplomi che hanno questo tipo di caratteristica.
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Mediante il comando AWARD CALCULATION si avvia il calcolo. Questo è il riassunto ottenuto. Con fondo ROSSO sono i QSO non ancora
confermati, con fondo VERDE sono quelli confermati, mentre quelli con fondo GIALLO sono i QSO confermati via LoTW (se si è iscritti a questo
sistema - vedi LoTW ). Cliccando con il tasto sinistro del mouse su una casella la si seleziona (il colore del fondo diventa blu, come nell'esempio
sopra 3A2MD) a questo punto con il tasto destro del mouse si apre un menu che ci consente di selezionare quel QSO come ACCREDITATO (in
questo caso dal DXCC Desk). Il colore del fondo muterà in AZZURRO.  Dal momento che il QSO che il DXCC Desk ci ha accreditato potrebbe
non essere quello presentato dal programma, abbiamo la possibilità di cambiarlo, sempre con tasto destro del mouse, opzione Cambia Call per
Accredito. Un box mostrerà tutti i QSO con quel County e in quelle condizioni (bande, modi) tra cui sceglieremo quello effettivamente
accreditato. La situazione può essere esportata in testo o in Excel. Un doppio click apre la finestra di inserimento/visualizzazione QSL. Sotto la
barra con il nome dell'Award sono riassunti in modo particolareggiato i dati numerici. Premendo ad esempio su Confermati si aprirà il report
come nella figura qui sotto:
 

 
Selezionando DXCC STATUS si aprirà il seguente riquadro:
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Nella prima colonna sono gli Award DXCC gestibili, nella colonna SELECTED si riverseranno i Country confermati via LoTW. Per il
funzionamento del sistema LoTW si veda l'apposito sito Web oppure si scarichi il PDF esplicativo che si trova anche sul sito ARI Nazionale
tradotto in italiano. In sostanza dall'incrocio dei log l'ARRL vi potrà assegnare delle conferme virtuali di QSO che potranno essere trasformate in
accrediti anche senza la QSL cartacea. BBlogger può interfacciarsi con LoTW : http://www.arrl.org/lotw/ si veda questa pagina.
Le conferme via LoTW vengono evidenziate in colore di fondo GIALLO nella griglia del DXCC MIXED (la prima figura in alto). A questo punto
possiamo evidenziare i QSO per cui abbiamo deciso di richiedere l'accredito all'ARRL evidenziandoli sulla griglia (click con tasto sinistro) e poi
con il tasto destro del mouse selezionando APPLIED. Il fondo muta colore e diventa VIOLETTO. Questi QSO, o meglio il numero di questi
Country verrà trasferito dalla colonna SELECTED alla colonna APPLIED. La colonna AWARDED indica i Country che l'ARRL ci ha accreditato.
Questi accrediti possono avvenire per esposizione delle QSL oppure per via telematica mediante il sistema LoTW. Nella nostra griglia saranno
con fondo AZZURRO. Quando l'ARRL avrà accreditato i Country che avremo richiesto con la procedura on-line potremo trasferisli nella colonna
AWARDED mediante l'apposito tasto APPLIED > AWARDED che si trova in alto a sinistra nella schermata DXCC STATUS. Si pone l'accento sul
fatto che il sistema LoTW non è il fine ma il mezzo: è un sistema per poter avere l'accredito DXCC senza avere in mano la QSL. E' valido
attualmente solo per DXCC e WAS , per gli altri diplomi è necessario avere le QSL cartacee. La colonna TOTAL/CURRENT contiene i Countries
Accreditati Totali e Attivi. I totali comprendono anche le entità deleted mentre gli attivi sono solo quelli in vigore in data odierna. Le ultime due
colonne sono le entità DXCC lavorate e confermate (sia con QSL cartacea che con conferma LoTW) conteggiate solo sulla base delle
informazioni contenute nel log. Si noti che l'Award CHALLENGE si basa solo sulle entità attuali in quanto per questo Award non sono valide le
entità deleted. Importante: iniziate a scaricare i file adif da LoTW solo dopo aver allineato la vostra situazione crediti con quella ufficiale
ARRL, pena la non esattezza dei dati che saranno presentati dal programma. E' possibile resettare tutti i crediti azzerandoli con il tasto che
riporta un triangolo con il punto esclamativo in alto a sinistra. Vedi QUI per le procedure LoTW con BBLogger
 
La Sezione CQ AWARDS gestisce tutti quegli awards sponsorizzati dalla rivista CQ, cioè il CQDX, l' U.S. Counties Award, cioè il Diploma delle
Contee U.S.A., il WAZ e il WPX.
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Nell'immagine esemplificativa si può vedere il resoconto grafico che riguarda le Contee dello Stato della Pennsylvania (ROSSO = lavorate,
VERDE = confermate). Vi sono 50 mappe per i 50 Stati dell'Unione, per un totale di 3077 Contee. Tutte le mappe sono scalabili e possono
essere salvate come immagine con la propria situazione.
 
La Sezione CASTLES/ABBEYS AWARDS gestisce i Diplomi relativi a Castelli e Abbazie, La Sezione ISLANDS AWARDS gestisce lo IOTA e
vari Diplomi nazionali delle isole, la Sezione FLORA FAUNA gestisce il WFF e numerosi Diplomi Flora Fauna nazionali.
La Sezione ITALIAN AWARDS e la Sezione POLISH AWARDS gestiscono i Diplomi di Italia e Polonia
La Sezione OTHER AWARDS gestisce tutti gli altri diplomi gestibili da BBLogger, ad eccezione delle TOPLIST che vengono gestite dalla
Sezione dedicata, insieme con le STATISTICHE.
Per i Diplomi Custom si veda il paragrafo apposito
Naturalmente per poter effettuare questi calcoli è necessario che per ogni QSO siano stati riempiti gli appositi campi relativi agli award gestiti,
vedi Inserimento QSO Ovviamente bisognerà riempire i relativi campi dei vecchi QSO che sono stati importati da altri programmi Log. Questo si
può fare selezionando il QSO e riaprendolo con F4 o con il tasto destro del mouse. Molte informazioni possono essere assunte
automaticamente dal Callbook: per esempio un QSO con una stazione italiana ci potrà dire la provincia per il WAIP, un QSO conuna stazione
francese ci potrà fornire il Dipartimento per il DDFM e la regione per il DPF. Queste informazioni possono venir caricate automaticamente con la
combinazione Ctrl+Invio (Callbook selezionato) oppure Alt+Invio (QRZ.com). Altre informazioni sono da ricercare mediante l'elenco richiamabile
premendo il "fumetto" con la lettera "i" ed inserendole con un doppio click sulla griglia. Esiste un altro modo per inserire delle informazioni sui
vecchi QSO in maniera automatica:
AWARD AUTO CHECKING: nell'esempio raffigurato qui sotto abbiamo selezionato il DDFM e il DPF. Premendo il tasto Inizia il controllo il
programma scorre tutti i QSO con stazioni francesi e corse, ed inserisce tutti i dati trovati nel Callbook selezionato nei vari campi. ATTENZIONE
PERO': la routine sovrascrive tutte le informazioni a suo tempo registrate, e quindi potrebbe scrivere dei dati inesatti per il periodo in
cui fu effettuato il QSO. Se ad esempio avete collegato un OM che nel 1992 abitava ad esempio nel Dipartimento nr. 13 e oggi abita nel nr. 84,
la routine inserirà il dato odierno, che trova nel Callbook, e quindi avrete un dato falsato. Oppure alcuni call potrebbero aver cambiato nel
frattempo "proprietario", specie i call USA, e quindi importerete dei dati totalmente errati sovrascrivendo quelli esatti che avevate annotato al
tempo in cui venne effettuato il QSO. Usatela quindi con molta cautela e verificate sempre sulle QSL i dati che avete introdotto! Inoltre la
routine passa in rassegna tutti i QSO coinvolti nella gestione di quell'Award e quindi potrebbe impegnare le risorse del vostro
computer per un tempo anche molto lungo. Ovviamente questo dipende dal processore e dalla RAM del vostro computer. Se avete una
macchina piuttosto vecchia si potrebbe facilmente bloccare. Questa Utility contiene anche la procedura per trasportare una referenza IOTA, DAI
o DCI dal campo comment ai rispettivi campi di BBLogger, per log già importati in precedenza.
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Alcuni Award possiedono una visualizzazione grafica dello status. In tal caso comparirà un'altra linguetta a destra di Application Informations
denominata MAPS: premendola apparirà la mappa con le entità diversamente colorate: BIANCO per non collegate, ROSSO per collegate non
confermate, VERDE per confermate e AZZURRO per le entità accreditate (solo per alcuni diplomi, es. DXCC). Nel caso del DXCC le mappe con
la propria situazione si possono salvare nel formato desiderato e stampare.
 

 
Nell'esempio vediamo la raffigurazione grafica dello SP-PA, cioè  il diploma delle contee polacche. La mappa si può adattare alla risoluzione del
proprio monitor mediante i pulsanti Zoom In e Zoom Out, e si può stampare con il pulsante Print.
 
AWARD CALCULATION fa calcolare il nostro score per quel particolare Award, DOC APPLICATION produce un form standard per richiedere
l'Award DXCC in formato Excel o Calc. Per gli altri Awards si possono generare degli elenchi sempre in Excel o Calc con DATA Export. -
attenzione: alcuni Awards vogliono dei form dedicati, comunque questo programma può generare un elenco dei QSO atto ad essere
copiato/allegato al form originale - DATA Export contiene EXPORT IN EXCEL (oppure EXPORT IN CALC se è installato Open Office al posto di
Microsoft Office) e EXPORT IN ADIF.Con PRINT VIEW potremo visualizzare e stampare le griglie dei vari Awards e con SALVA SETTINGS
potremo salvare bande, modi e continenti selezionati. Per il DXCC il comando DATA Export produce una ripoduzione colorata della griglia che
appare dopo aver premuto Award Calculation in formato Excel o Calc.
 



 
La Sezione AWARD TOPLIST gestisce le classiche TOPBAND, TOPLIST e TOPMODE, e inoltre le TOP SQUARES V/U/S/EHF ed HF. Qui si
possono avere tutte le statistiche, comprese le gestioni grafiche di FIELDS e SQUARES WWLOCATOR.
 

 
Nella stessa Sezione abbiamo anche STATISTIC BAND e STATISTIC MODE dove è possibile calcolare e visualizzare graficamente le proprie
statistiche per bande e modi:
 



 
 
 
 
 
 
 
I 151 DIPLOMI GESTIBILI CON LA VERSIONE CORRENTE DI BBLOGGER:
 
DXCC - DX Century Club CQDX - CQ DX Award IOTA - Islands On The Air WAZ - Worked All Zones
WPX - Worked all Prefixes WAC - Worked All Continents BCA - Belgian Castles Award C19D - Departments of Uruguay
CCC - Commonwealth Century
Club

CDM - Certificate of the
Mediterranean Sea CORA - Cities Of Russia Award DAI - Italian Abbeys Award

DCI - Italian Castles Award DCS - Swiss Castles Award DCE - Spanish Castles Award DCIN - Insubric Castles Award
DFCF - French Forts and Castles
Award

DDFM - French Departments
Award DPF - French Regions Award DLI - Italian Lakes Award

DIE - Spanish Islands Award DIEI - Spanish Inland Islands
Award DME - Spanish Communes Award DLD - German DARC Sections

Aw. (DOK)
H26 - Swiss Cantons Award IIA - Italian Islands Award IOCA - Islands of Croatia Award IOSA - Islands of Scotland Award
JCC - Japan Century Cities JCG - Japan Century Guns MIA - Mediterranean Islands Award MMIL - Russian Oblasts Award

RDA - Russian Districts Award SPPA - Polish Counties Award
(Powiaty) TOPMODE TOPBAND



POLSKA Award (Polish Provinces) TPEA - Spanish Provinces Award TRA - Argentinian Provinces Award URDA - Ukrainian Districts Award

TOPLIST USA-CA - U.S.A. Counties Award ARLHS - Lighthouses Award WACE - Worked All Chile (Call-
areas)

WABRA - Worked All Brazil
(States)

WAIP - Worked All Italian
Provinces

WAJA - Worked All Japan
(Prefectures) Award WAS - Worked All States (USA)

WASL - Worked All Swiss Lakes WAU - Worked All Ukraine
(Oblasts of Ukraine) GIA - German Island Award DIA - Danish Island Award

DIFM - French Islands Award GCOTA - German Castles On
The Air Award

CASHOTA - Castles And Stately
Homes On The Air

COTA-RUSSIA - Russian Castles
Award

CANADAWARD -
Provinces/Territories of Canada CISA - Canadian Islands Award USISL - United States' Islands Award DCTI - Castles of Ticino Award

HOLYLAND - Israelian Squares
Award

WALA - Worked All LA
(Norwegian Counties)

WANCA - Worked All Norwegian
Communes Aw.

WWFF - World Wide Flora Fauna
Award

WASA - Worked All Sweden Award SCA - Swedish Communes
Award IFFA - Italian Flora Fauna Award DMI - Italian Municipal Buildings

Award
EURA - European Union Regions
Award

DAI VFOA - Via Francigena On
Air Award WAB SQUARES Award WAB DX Award

WAB ISLANDS Award WAB LARGE SQUARES Award WAB CHANNEL ISLAND Award WAB BOOK HOLDERS Award
WAB OVERSEAS BOOK
HOLDERS Award

WABP - Worked All Belgian
Provinces Award

RAAG Award - (Greek Call Areas
Award) CCA - Croatian Counties Award

WAHUC - Worked All HUngarian
Counties Award

IARU R1 All Bands –W orked R1
IARU Members

IARU R1 28 MHz –W orked R1 IARU
Members on 10 m. DDI - Italian Dioecesis Award

WLOTA - World Lighthouses On
The Air Award SOTA - Summits On The Air SCOTIA - Scottish Islands Award DIFO - Overseas French Islands

Award

ATDA - All Turkey Districts Award DIP - Diploma dal Ilhas
Portuguesas JIA - Japan Islands Award PIP - Portuguese Islands Plaque

ROMANIA - Romanian Counties
Award

RRA - Russian Robinson Award
(Russian Islands)

SPIA - SP Islands Award (Polish
Islands)

IDCA - Italian Districts by Castles
Award

DAS - Swiss Abbeys Award DAIN - Insubrian Abbeys Award WVA - World Volcanoes Award DAV - Volcanic Environments
Award

PGA - Polish Gminy Award GIOTA - Greek Islands On The
Air Award

DXCC DIAMOND - 75° Y ears of
DXCC Award

OK COUNTIES AWARD - Czech
Counties Award

OM DISTRICTS AWARD - Slovak
Districts Award

DVGE - Spanish "Vertices
Geograficos" Awd. WCA -World Castles Award 9A COTA - Croatian Castles

Award
S5 COTA - Slovenian Castles
Award SCA-OM - Slovak Castles Award CCA-OK - Czech Castles Award ZWP - Polish Castles Award

RHO - Romania Historical Objects
Award

YL COTA - Latvian Castles
Award

DCFP - Portuguese Castles and
Fortresses Award

DMHP - Portuguese Historical
Monuments Award

IDES - Imperios do Divino Espirito
Santo (Port.) Awd.

9AFF - Croatian Flora Fauna
Award

DLFF - Deutschland Flora Fauna
Award

DPRN - Portuguese Park and
Nat. Reserves Awd.

E7FF - Bosnia and Herzegovina
Flora Fauna Award

EAFF _ Spanish Flora Fauna
Award EIFF - Irish Flora Fauna Award EWFF - Belarus Flora Fauna

Award
EXFFA - Kyrgyzstan Flora Fauna
Award FFF _ France Flora Fauna Award GFF - UK - Ireland Flora Fauna

Award
GMFF - Scottish Flora Fauna
Award

HAFF - Hungarian Flora Fauna
Award

LYFF - Lietuvos Flora Fauna
Award LZFF - Bulgarian Flora Fauna Award MFF - Moldovan Flora Fauna

Award

OEFF - Austrian Flora Fauna Award ONFF - Belgian Flora Fauna
Award RFFA - Russian Flora Fauna Award SMFF - Swedish Flora Fauna

Award

SPFF - Polska Flora Fauna Award SVFF - Greece Flora Fauna
Award UNFF - Kazakh Flora Fauna Award URFF - Ukrainian Flora Fauna

Award
YOFF - Romanian Flora Fauna
Award

Z3FF - Macedonian Flora Fauna
Award ASC - ARI Section Codes Award NUOVO IIA - Italian Islands

Award

LDK - Landkreis Award DMF - French Mills Award DPI - Italian Harbors Award DIA (IT) - Italian Archaeological
Award

DVR - Roman Ruins Award DEE - Diploma Ermitas de
España

EUCC - European Union Counties
Challenge  

 
Nota: a partire dalla Release 1025 built 006 BBLogger va a sostituire integralmente Visual DAI
nella gestione del DAI, Diploma delle Abbazie Italiane. In QUESTA PAGINA troverete le
istruzioni per la migrazione da Visual DAI a BBLogger e per la gestione DCI con BBLogger.
 

 

http://www.aribusto.it/BBHelp/migrazioni.htm
http://www.aribusto.it/BBHelp/IndexBBH.htm
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Custom Awards
 

 
Nella casella Award Name inserirete il nome o la sigla del nuovo award che state creando, nel campo Description se lo volete potete inserire una
breve descrizione (ad esempio se avete optato per una sigla nel campo Award Name). Per esempio scriviamo DSF in Award Name e "DIploma
Stazioni Ferroviarie" (Italian Railroad Stations Award) in Description.  Segue il menu delle entità DXCC. Come vedete è spuntato ITALY, perché il
programma legge il vostro Country e lo spunta, ma se volete potete spuntare manualmente i Country che desiderate, nel caso stiate elaborando
un award multinazionale, anche tutti, con l'apposito checkbox. Per il nostro esempio - un diploma italiano - spuntiamo anche la casella
SARDINIA. A questo punto premete OK e una scritta vi avvertirà che il diploma è stato correttamente creato. Ora dobbiamo collegare il nostro
RSA ad un database. Questo database può essere un file di tipo Excel o TXT. Deve contenere tre campi: il campo "CODICE REFERENZA", il
campo "DESCRIZIONE", e il campo "WWL". Quest'ultimo può anche essere vuoto. Nel caso di un TXT i campi sono separati da un carattere
";"

Una volta creato il Diploma si aprirà una schermata come questa:
 

 
C'è un tasto LOAD REFERENCE FILE: premetelo e andate a collegare il file Excel o TXT che avrete creato in precedenza. Nel nostro esempio
avremo una sigla per la referenza  e una descrizione della referenza. Quando costruite un database in riga 1 scrivete quello che volete. tipo REF
e DESCRIZIONE, o SIGLA e NOME, non ha la minima importanza. Una volta collegato al database la dicitrura "no award file" cambierà
mostrando il path del file collegato. Quello che è importante è che cominciate a listare le referenze da riga 2. con F2 apriamo il modulo di
inserimento QSO e digitiamo un call:
 

Cliccando sull'icona CUSTOM AWARDS compare il menu con le voci Crea Nuovo Award, Edit Custom Awards e Custom Awards Manager.
Cliccate su Crea Nuovo Award e vedrete questa finestra:
 

https://translate.google.com/


 
clicchiamo su Custom Awards e vedremo questa schermata (all'inizio senza la griglia di destra). Cliccando sul fumetto con la "i" si aprirà la
griglia dalla quale come al solito potremo selezionare la referenza ed inserirla col doppio click, nell'esempio abbiamo inserito DSF-GE046 la
Stazione di Rapallo.Salviamo il nostro QSO come al solito (se avete attivi i vari invii automatici a eQSL, Clublog, eccetera, disattivateli oppure
usate un log di prova senza questi automatismi, se no poi dovete andare a cancellare a mano le entry di prova):
 

 
Da Custom Awards Manager potremo ora gestire il nostro award custom come tutti gli altri, quindi con Award Calculation vedere quante
referenze abbiamo collegato, le conferme, gli accrediti, ecc. Ovviamente dovremo fare a mano gli accrediti: cliccando su un call nella griglia col
tasto sinistro per selezionarlo e poi cliccando col tasto destro potremo aprire il QSO, o segnarlo come accreditato/non accreditato. Con Data
Export potremo esportare in Excel o in ADIF il nostro score e infine con Elimina Award potremo cancellare l'Award e tutti i dati immessi nei vari
QSO relativi a quell'Award. I QSO non verranno cancellati, solo i dati relativi a quell'Award lo saranno. Al momento è previsto solo l'utilizzo dei
formati Excel e TXT:
 



 
Se dovete aggiungere o modificare referenze al vostro database-custom, non c'è problema: fate tutte le aggiunte / modifiche che volete e poi da
Edit Custom Awards rifate la procedura Load Reference File per renderle effettive:
 

 
Sempre da Edit Custom Awards potrete modificare ad esempio le entità DXCC per le quali fare apparire il box di quel determinato Award,
selezionando le caselle opportune.
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Procedura LoTW
Procedura per l’inserimento dei QSO in LoTW con BBLogger:

 

Prerequisiti:

       BBLogger

       Account LoTW attivo, relativo certificato di firma valido e Software (TSQL e TSQLcer
V1.13)

 Setting parametri upload/download automatico LoTW

(italiano)
 
Procedura automatica:

- Per prima cosa bisogna inserire i parametri necessari per il funzionamento della procedura: da Log > Modifica Dati User scegliere il Call User e premere OK.

- Ora premete QSL Service. Nella sezione LoTW Service inserite i parametri: UserName: il vostro Callsign; Password: è quella che vi ha inviato l'ARRL per
accedere al servizio. TQSL Pw è l'eventuale password che avete scelto per utilizzare il programma di firma elettronica TQSL. Può esserci o non esserci. TQSL
Station: è solitamente il vostro QTH, o comunque la stessa cosa che avete nel rispettivo box del programma LoTW. Fate attenzione ad inserire alla voce TQSL
Station l’indicazione del QTH senza il nominativo che lo precede, a differenza di quanto appare nella finestra Edit Station Location del programma TQSL.

- Cliccate di nuovo su OM Data e premete OK.

- Ora aprite da File > Files Manager  e premete su LoTW Management.  Dovreste avere una situazione come in figura:

-  In TQSL exe bisogna indicare il path che conduce all'eseguibile tqsl.exe che ci consentirà di firmare digitalmente il nostro file. Nell'esempio che vedete nella
figura il path è C:\Programmi\T rustedQSL\tqsl.exe

-  Potete selezionare se inviare i QSO non ancora inviati (QSO NOT SENT) oppure tutto il log (ALL QSOS)

- Cliccate su Start Upload: il programma elaborerà un file e lo salverà con il nome "LOTWUpload_YYYYMMDD.tq8" (YYYYMMDD sono anno, mese e giorno
in cui avete salvato il file) nella subdirectory FilesAdif

- Un riquadro vi chiederà se il file che state per salvare sarà inviato a LoTW . Rispondete "Sì" e la procedura automatica vi porterà alla vostra pagina in LoTW ( per
questo è necessaria la Password)

:

- Premete il tasto "Sfoglia" , andate nella cartella FilesAdif e selezionate il file appena creato.

- Premete il tasto Upload File.

- Dopo qualche istante comparirà la scritta "File LOTWUpload_YYYYMMDD.tq8 queued for processing".

- N.B. Non aspettatevi di veder apparire subito i vostri QSO e le vostre QSL su LoTW; ci vorranno decine di minuti, a volte anche ore, a seconda del carico del
server dell’ARRL. Chiudete tutto e tornate più tardi a verificare.

 
Procedura per l’inserimento delle conferme di LoTW in BBLogger:

https://translate.google.com/
http://www.bblogger.eu/
http://www.arrl.org/instructions
http://www.youtube.com/watch?v=XR4O1Td-Bpc


 

Procedura accrediti LoTW

In BBLogger:

-          Selezionare il menù File > Files Manager

-          Selezionare il tag LoTW Management

-          Cliccare su Start Download  ovviamente dopo essevi assicurati che i campi UserName e Password sono stati correttamente compilati

BBLogger salverà il file C:\BBLogger\DownloadFile\LoTwReport_YYYYMMDD.adi (data in cui effettuiamo il download delle QSL nel formato YYYYMMDD).

-          Confermiamo.

-          L'importazione avviene in automatico

-          Confermiamo la richiesta di importazione

-          Verrà anche creato un file di errori che eventualmente potremo consultare (di solito del tipo:
C:\BBLogger\FileAdif\ImportError\Error_LoTWddmmyyy_hhmm.txt)

73 de

IW2NZX Cristiano.
 

http://www.youtube.com/watch?v=c5vbCrIYSM4
http://www.aribusto.it/BBHelp/IndexBBH.htm
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Procedure eQSL
Procedura per la creazione del file log e inoltro a eQSL.cc con BBLogger:

 
Prerequisiti:

       BBLogger

       Account eQSL.cc valido
In BBLogger:

-          Selezionare il menù File > Files Manager

-          Selezionare il tag Esporta Log in File

-          Impostare il Tipo File su ADIF Confirm eQSL

-          Ora dobbiamo scegliere quali QSO salvare nel file che poi verrà inviato a eQSL:

o    Eventualmente selezionare l’Origine del Log, se diverso da quello proposto

o    Inserire il commento che verrà inviato ad eQSL assieme a tutti i QSO (es.: “Tnx, Pse paper QSL via Bureau or LoTW,
73 GL GDX”, oppure “Abbazia XYZ”, ecc…)

o    Nella voce QSOs Filter impostare:

§   ALL QSOs per inviare tutti i QSO (di solito la prima volta che si caricano i QSO su eQSL)

§   EQSL NOT SENT per inviare soltanto i QSO che non sono ancora stati inviati a eQSL ovvero quelli con la voce
eQSL QSLs con “N”

-        Abilitare (se serve) la voce Filtro Date QSO nel riquadro di sinistra, ed impostare il range nel quale estrarre i QSO
da inviare a eQSL.

-        Per ultimo indicare il nome del File ADIF mediante il tasto \... in alto a destra, sempre nella finestra del Files Manager.
Salviamolo per esempio in C:\BBLogger\FilesAdif\IW2NZX.adi (al mio nominativo sostituite il vostro oppure altro a vostro
piacimento).

-        Alla domanda “Questo file verrà inviato a eQSL” se si risponde SI, BBlogger imposterà automaticamente il valore “Y” nel
campo eQSL QSLs a tutti i QSO che stanno per essere inviati a eQSL, quindi questi non saranno più presi in considerazione
per il prossimo invio.

Ecco come si presenta la Finestra di Files Manager

 

-   Il file così creato andrà poi caricato su eQSL;

https://translate.google.com/
http://www.bblogger.eu/
http://www.eqsl.cc/


-             Aprire col proprio browser preferito l’indirizzo http://www.eqsl.cc

-        Inserire il proprio username e password per accedere a eQSL

-        Cliccare sul tab Upload ADIF:     

-        Scorrete la pagina e col tasto Sfoglia indicare il file .adi precedentemente creato : (C:\BBLogger\FilesAdif\IW2NZX.adi o
simile)

-        Cliccare su Upload File

N.B: Cliccando sulla scritta Date of Last ADIF Upload , eQSL vi risponderà con la data dell’ultimo upload del file .adi, in modo da
ricordarvi l’ultima volta che avete caricato i vostri QSO.

Segue la Procedura per l’inserimento delle QSL di conferma di eQSL in BBLogger .

In alternativa all'invio cumulativo è possibile inviare la conferma eQSL per ogni singolo QSO richiamando il contatto con F4/doppio
click sulla relativa riga nella griglia-log e riaprendo il modulo:

Cliccare sulla linguetta eQSL, se si vuole si può inserire un messaggio nel box Message, e con il tasto CFM to eQSL si invia la
conferma in tempo reale.

 
Procedura per l’inserimento automatico delle conferme eQSL e relative immagini

in BBLogger:
 
In BBLogger:

-          Selezionare il menù File > Files Manager

-          Selezionare il tag eQsl/DM780/QRZ.com

-          Cliccare su Download eQSL file report

http://www.eqsl.cc/


BBLogger scaricherà automaticamente il file delle conferme.

-          Clicchiamo sul tasto Sì, il programma ci dirà quante eQSL stanno per essere importate e chiederà conferma. Al
successivo Sì l'imporazione delle eQSL inizierà.

-           Allo stesso tempo saranno visualizzati i QSO non importati in breve nella finestra Process, e più completamente nella
finestra QSO NOT IMPORTED. Verrà creato anche un file di questi errori di importazione consultabile in   qualsiasi momento.

-          Al termine del processo sarà visualizzato il numero dei QSO importati. A questo punto da Tipo File si può scegliere ADIF
eQSL Cards Image e il programma importerà le immagini eQSL associandole al relativo QSO. Anche in questo caso al
termine del processo verrà visualizzato il numero totale di immagini importate:



Le eQSL saranno visibili selezionando un QSO dalla griglia e premendo F4 (o doppio click, secondo quanto è stato scelto in
Global Setting del menu Configurazione/Manutenzione). Se quel QSO è confermato dalla sola eQSL lo sfondo della riga
sarà di colore BLU CHIARO. Nel caso vi sia anche conferma mediante cartolina QSL prevale il colore VERDE relativo alla
QSL cartacea.

Anche l'output prodotto dal Menu Ricerche consente di visualizzare le eQSL. In questo caso una icona DISPLAY sarà
visualizzata nella colonna di destra se vi è presenza di immagine associata, sia essa eQSL che scan di QSL cartacea.

-          P.S.: E’ possibile trasformare il file .adi appena scaricato in un file ADIF normale, eventualmente per recuperare i QSO
eventualmente a seguito di una perdita di dati, modificando il file scaricato con la procedura di cui sopra ed editando con il
Blocco Note l’header del file, cancellando la prima riga, fino all’<EOH>. Per importarlo come file ADIF normale, nel menù
File > Files Manager, selezioniamo il tag Importa File > LOG, impostiamo Tipo File con ADIF Log Generic ed il gioco è
fatto. (Attenzione che BBLogger controlla l’header , quindi se non cancellate la prima riga, il file verrà importato sempre come
conferme e non come LOG normale!)

-          73 de

-          IW2NZX Cristiano.
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QSL Manager
 
Questa sezione consente di tenere sott'occhio la propria situazione QSL, siano esse cartacee o elettroniche:
 

 
Come si può vedere si possono controllare le QSL inviate, ricevute, non inviate, non ricevute, ritornate e in attesa (via diretta), per
uno o più log. Tutte le colonne si possono ordinare in senso alfabetico o viceversa, e secondo date crescenti o decrescenti, inoltre
ogni QSO è pienamente editabile. Con un doppio click si può vedere/associale l'immagine della QSL.
Inoltre si possono fare ricerche per call. E' anche possibile dalla versione 1.0.1.8 tenere un archivio delle QSL spedite a SWL. Inoltre
è possibile vedere la data di spedizione e di ricezione della QSL.
Gli archivi si possono esportare in ADIF. Il comando eQSL/LoTW Table azzera le conferme di eQSL e LoTW. Pertanto se non
coincidono i numeri si può azzerare tutto e importare di nuovo il file ADIF ricevuto da eQSL o da LoTW con la procedura File > Files
Manager > Importa File > LOG, selezionando il tipo di file (ADIF Confirm eQSL oppure ADIF Report LoTW) e indicando il log
destinazione
 

https://translate.google.com/
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Modo SWL
 
Generando un nuovo log in modalità SWL alcuni aspetti verranno conseguentemente modificati. La finestra di inserimento HRD
diventerà così:
 

 
Nel box CALL HRD ovviamente si dovrà inserire il nominativo della stazione ascoltata, e nel box IN QSO il nominativo dell'altra
stazione in QSO con la stazione ascoltata. Una volta inseriti tutti i dati dell'ascolto, si salva il HRD con il tasto apposito oppure con la
combinazione CTRL+S. A questo punto, se abbiamo un ascolto valido anche della stazione corrispondente, premendo il tasto HRD
REVERSE si invertono automaticamente i dati CALL HRD e IN QSO. Questo dà la possibilità di loggare in tempo reale entrambe le
stazioni ed inviare la QSL ad entrambi. Una volta sistemati i rapporti si salva l'HRD come già visto. Il tasto QSL MANAGER Local
ricerca il manager nel database dei Manager, il tasto QSL MANAGER On Line lo ricerca nel sito www.ik3qar.it , e se il dato è
presente, lo farà comparire nell'apposita casella, in alternativa il call del manager può essere inserito una volta acquisito
direttamente dalla stazione DX o da cluster o da altre fonti informative.
Anche la stampa delle etichette e delle QSL sarà convenientemente modificata per adattarsi alle esigenze degli SWL. Tutte le altre
funzioni sono le stesse del modo Hunter
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BB Terminal
 

BB Terminal è un terminale integrato nel programma per la gestione dei QSO nei Modi FSK31, GMSK, MFSK8, MFSK16, PSK31, PSK63,
PSK125, QPSK31, QPSK63, QPSK125, RTTY a 45 baud, RTTY a 75 baud, RTTY in FSK Normale e RTTY in FSK reverse. Esso funziona
mediante il famoso motore MMVARI ® messo a punto da Makoto Mori, JE3HHT. Viene attivato dal menu STRUMENTI selezionando la voce
BBTerminal. Comparirà la schermata del BBTerminal sovrapposta al foglio log. Se non si aprisse, cliccate sull'icona di BBLogger sul
desktop con il tasto destro del mouse e selezionate Proprietà. Cliccate sulla linguetta Compatibilità e spuntate la casella
"Esegui il programma in modalità compatibilità per" -> Windows XP. Assicuratevi inoltre di lanciare il programma con i
privilegi di amministratore. Click col tasto destro del mouse sull'icona di BBLogger sul Desktop e poi "Esegui come
amministratore".

 

 
Il terminale occupa la parte inferiore dello schermo e può essere visualizzato alternativamente al foglio log cliccando sulla linguetta sopra la
barra. Questo è l'aspetto del terminale:
 

 
Il terminale è suddiviso in diverse finestre: nella parte superiore abbiamo la finestra dove possiamo vedere i segnali, al di sotto la finestra di
traffico, più sotto ancora la barra con le Macro e in basso la finestra diel testo che viene trasmesso. A sinistra in basso abbiamo nella sezione
INFO le finestrelle per l'inserimento di CALL, NOME, RAPPORTO, QTH, LOCATORE e COMMENTI, e i menu a tendina dove selezionare
BANDA e MODO di emissione, al momento sono 14, come già visto. Attenzione: a fianco del modo scelto una finestrella blu vi indicherà
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come deve essere impostato il selettore della radio per quel modo: in RTTY 45b e 75b bisogna settare la radio su LSB sempre,
indipendentemente dalla banda, in RTTY FSK normale e Reverse il selettore va su FSK mentre in tutti gli altri modi digitali il selettore va
sempre posto su USB. Accanto alla finestra del nominativo vi sono due finestrelle che, accendendosi, indicano l'appartenenza di quel call a
EPC e LOTW. Il menu a tendina QSLs consente di registrare in tempo reale il comportamento relativamente all'invio della QSL per quel
contatto. Sotto lo schermo dove vengono visualizzati i segnali vi sono alcune finestre e comandi: in quella più a sinistra (che mostra uno zero)
si può muovere l'indicatore grafico di frequenza in avanti o all'indietro a passi di 10 Herz. S/N =ndB mostra l'intensità del segnale, il tasto W.F.
alternativo a FFT consente di mostrare i segnali in modalità cascata oppure onda, infine il tasto AFC consente di inserire l'Automatic
Frequency Controller oppure di disinserirlo (on/off). Selezionando la linguetta SETUP abbiamo SETTINGS che apre una finestra nella quale si
possono selezionare la Sound Card (se ce ne fosse più di una) i livelli del volume digitale per la linea in uscita, il tasto Mixer Audio apre il
programma interno di settaggio della soundcard, e TxComPort consente di selezionare la COM port alla quale è connessa l'interfaccia per i
modi digitali. Il programma consente di scegliere una porta fisicamente esistente. Se non vi sono porte seriali installate occorrerà munirsi di un
convertitore USB-COM. Con AutoCq Delay si può selezionare il numero di secondi tra una trasmissione e l'altra se viene utilizzato il tag
AutoCq (vedi più avanti): La sezione My RSQ consente di scegliere il tipo di rapporto da dare: con 599+ si dà il 599 (di default abbiamo quello
ma si può  cambiare a piacimento) da solo o eventualmente si può aggiungere qualche altro dato fisso, esempio 599-VA se oltre al rapporto
dobbiamo dare la Provincia; con 599+001 si dà il rapporto aggiungendo un numero seriale, che si incrementa ad ogni salvataggio di QSO; e
con 599+001+UTC viene aggiunto anche l'orario UTC. Questo può essere utile in caso di manifestazioni radioamatoriali, diplomi o contest.
Ribadiamo però che questo non è un programma concepito per gestire un contest. Il tasto Font Rx Window consente di cambiare
carattere e dimensioni dello stesso nella finestra di traffico. Infine abbiamo la scelta tra PTT su RTS oppure PTT su DTR:
non tutte le interfacce radio<>PC homemade sono uguali. Alcune lavorano con PTT su DTR ( filo 4 di connettore seriale a 9 pin) mentre altri
usano il PTT su RTS (filo 7 della seriale). Se non siete a conoscenza del tipo della vostra interfaccia provate l'una o l'altra configurazione e
scegliete quella delle due che vi manda in trasmissione il TRX quando premete il tasto TX di BBTerminal. La commutazione in trasmissione e
ricezione può essere realizzata anche con la combinazione di tasti Alt+T e Alt+R. Il checkbox REC consente di registrare in un file di testo il
traffico nella finestra del BBTerminal. La finestra dove compaiono i segnali sotto forma di cascata o di picco contiene anche un misuratore
dell'intensità del segnale selezionato in dB.
Cliccando sulla finestra di traffico con il tasto destro del mouse si aprirà un sub-menu con 4 opzioni:
 

 
Open subchannels consente di aprire fino a 20 sottocanali che fungono da monitor dei vari segnali ricevuti:
 

 
L’apertura del sottocanale mette un marker sulla waterfall principale e quello è il punto di ascolto che possiamo modificare a mano spostando
il cursore. Dalla finestrina monitor selezionando il callsign ricevuto, esso andra a popolare il box CALLSIGN e sposterà il cursore TX in
corrispondenza per poter effettuare il qso.
Le altre voci del menu sono: Set notch on here che inserisce un notch-filter nel punto desiderato per migliorare la ricezione del segnale (il
punto è quello dove si clicca con il tasto destro del mouse per far apparire il menu secondario) il notch si può spostare con iltasto sinistro del
mouse ed eliminare con il tasto destro; Delete all notches che elimina tutti i notch inseriti, e Set TX carrier here che sposta la portante nel
punto desiderato mentre la ricezione rimarrà nella posizione precedente (per avere di nuovo freqTX = freqRX occorre riandare su
Setup>Options e selezionare NET)
Cliccando con il tasto sinistro su un elemento comparso nella finestra di traffico possiamo evidenziarlo e con il tasto destro trasportarlo in una
delle finestre di sinistra. Possiamo importare dati nelle finestrelle Callsign, Name, QTH, Locator e  Comment. Se contemporaneamente è
aperta la finestra del QSO (F2) il Callsign viene importato anche lì con interrogazione del callbook, se presente, ed inserimento dei dati. Se la
finestra QSO (F2) non era aperta, il Nominativo può essere importato anche in seguito cliccando nella finestrella Callsign e dando un Invio.
Possiamo importare nella finestra F2 anche Nome, QTH, Locator e Commenti con un doppio click nelle relative finestrelle. Un DOPPIO
CLICK sul Callsign apre la finestra F2-Dati QSO importando i dati dal Callbook se presente
 



 
MY TAGS fa comparire un box in cui inseriremo le informazioni relative a noi stessi e alle nostre apparecchiature, che utlizzeremo negli
scambi di dati durante i QSO digitali:
 

 
OPTIONS fa comparire un menu con le seguenti  voci:
NET (fTx = fRx): se è selezionato la frequenza di trasmissione e quella di ricezione coincidono. Deselezionato consente di trasmettere e
ricevere con uno shift a piacere (split mode)
View Frequency Width visualizza la larghezza di banda visibile e con il menu a discesa è possibile selezionare una larghezza di banda di
400, 800, 1000, 2000 o 3000 Hertz
RTTY Filter mette a disposizione due tipi di filtro per RTTY: IIR e FFT.
 
TX è un tasto e consente di mandare manualmente in trasmissione l'apparato per la scrittura libera. In questa fase il tasto muta la sua label in
RX, se è ripremuto riporta l'apparato in ricezione.Call, Name, QTH , Locator e Comment possono essere riempite manualmente o con la
seguente procedura: se nella finestra di traffico compare un nominativo, è possibile selezionarlo con doppio click del tasto sinistro del mouse
e poi con il tasto destro importarlo nella finestra Call. Se abbiamo aperto anche la finestra di Inserimento QSO (con il tasto F2) il nominativo
verrà importato contemporaneamente anche nel box Call di quest'ultima. Analogamente potremo importare con la stessa modalità il nome nel
box Name (ma non nell' omonimo box della finestra Inserimento QSO, che conserva le informazioni importate dal callbook), il QTH, il Locator
ed un eventuale altro testo nel campo Comment. Tutte queste informazioni sono indispensabili per il funzionamento delle tag nelle macro che
andremo ad esaminare di seguito. La finestra RSQ  contiene il rapporto che passeremo, che è preimpostato a 599 ma si può variare in
qualsiasi momento e può aggiungere le altre informazioni viste in precedenza. Se abbiamo inserito un nominativo nel riquadro Call,
passandovi sopra il puntatore del mouse di aprirà un fumetto con le info su quel call, inoltre il colore del fondo del campo Call varia in accordo
con le condizioni già viste in Inserimento QSO
La barra sottostante contiene i pulsanti con le macro. Tutti sono editabili cliccandovi sopra con il tasto destro del mouse:
 

 
Nella finestra Name si scriverà l'etichetta del pulsante mentre nella finestra sovrastante si scriverà il testo. Si possono utilizzare le tag presenti
nella finestra di destra. Alcune macro sono preimpostate, altri pulsanti sono vuoti. Le tre caselle in basso hanno queste funzioni: Auto TX:
manda in trasmissione il transceiver prima dell'esecuzione della macro, Clear Text after TX pulisce la finestra inferiore dopo l'esecuzione
della macro, Auto RX after TX si pone in ricezione dopo l'esecuzione della macro.
le due finestre di destra sono destinate la superiore alla decodifica del segnale ricevuto, l'inferiore al testo da spedire. Si può scrivere un testo
e inviarlo premendo il tasto TX nella barra superiore oppure si può ricorrere alle macro. Queste ultime si possono lanciare o con il tasto
sinistro del mouse o con la combinazione Ctrl+F1, Ctrl+F2 eccetera. Vi sono due set di Macro alle quali si può accedere alternativamente con

http://www.aribusto.it/BBHelp/inserimento_qso.htm


la pressione dei tasti CTRL+MAIUSC. Vi è anche una funzione di AUTOCQ: immettendo la tag <AUTOCQ> prima del testo della macro verrà
ripetuta la trasmissione a cadenze regolari. Il numero dei secondi è regolabile a piacere da Setting. Al termine di ogni macro la radio passa
automaticamente in ricezione. Se desiderate che resti in trasmissione, aggiungete la tag <TX> alla fine del testo nella macro.
Il BB Terminal può essere aperto contemporaneamente alle altre finestre del programma. Con F2 si apre la finestra di inserimento QSO (che
ci fornirà tutte le info) e si può salvare il contatto con tutte le sue info nel nostro log che abbiamo aperto in quel momento. Il salvataggio del
QSO può avvenire anche senza aprire la finestra inserimento QSO utilizzando il tasto F12. Se non si utilizza BB Terminal è consigliabile
chiuderlo (dal menu Strumenti) dal momento che consuma memoria e se inutilizzato sovraffatica inutilmente il processore. La finestra BB
Terminal, così come le altre finestre Log e Cluster può essere staccata dalla sua sede mediante click sulla linguetta e trascinandola con il
mouse, e può essere ridimensionata a piacere. Avendo a disposizione due monitor può essere spostata anche sul secondo monitor. Un
doppio click sulla barra fa tornare la finestra alla sua posizione e dimensioni iniziali.
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Aggiornamenti
 
BBLogger ha la proprietà di aggiornarsi da solo.
Se si è connessi in rete, il programma vi dirà quando sono disponibili degli aggiornamenti mediante questa immagine che compare
nell'angolo in basso a destra dello schermo:
 

 
Premendo su SI si aprirà un riquadro che mostrerà gli aggiornamenti disponibili. Basterà quindi premere DOWNLOAD. Se non si
desidera aggiornare uno o più archivi si deve togliere il segno di spunta dal relativo checkbox.
Al termine del download il programma installerà i nuovi files automaticamente.
Quando la procedura sarà terminata apparirà un box di avvertimento:
 

 
Non solo gli archivi, ma anche le mappe si aggiornano da sole. In questo caso il programma deve essere chiuso per poter avvenire
l'aggiornamento. La routine d'aggiornamento lo fa da sola. Quindi se vedrete il programma chiudersi non temete: è del tutto normale.
Riaprendolo di nuovo sarà aggiornato.
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Disclaimer
 
BBLogger © è un programma creato da Radioamatori per i Radioamatori e per gli SWL. E' completamente gratuito e può essere
scaricato liberamente da Radioamatori e SWL. Nessuno è autorizzato a chiedere denaro o altre forme di compenso per la cessione
di questo programma, se non le spese per il supporto e la spedizione nel caso venga distribuito su CD e per posta. Il programma e i
database sono comunque di proprietà degli autori e della Sezione ARI di Busto Arsizio e non possono essere modificati in alcun
modo senza autorizzazione degli stessi. I Callbooks con i quali BBLogger lavora sono elementi aggiuntivi, di proprietà dei rispettivi
autori, e possono essere acquisiti con le modalità da essi previste. Non sono distribuiti dalla Sezione ARI di Busto Arsizio. Gli autori
inoltre mettono a disposizione il programma cosi come è, senza garanzie esplicite o implicite di funzionamento, e non possono
essere ritenuti responsabili di inconvenienti come malfunzionamenti, perdite di dati, o qualsiasi altro inconveniente legato all'utilizzo
del programma o presunto tale. Il programma è stato testato a lungo, si prega al riguardo di leggere le note introduttive, comunque,
come tutti i programmi, potrebbe presentare inconvenienti o malfunzionamenti (bug). Gli utenti possono segnalare questi problemi
tramite l'apposito Newsgroup all'indirizzo web http://groups.google.com/group/bblogger?hl=it , così come possono proporre
variazioni e/o migliorie al programma. Si prega di usare esclusivamente il Newsgroup, evitando di scrivere direttamente agli autori,
dato che sia le domande che le risposte possono essere utili a tutti gli utilizzatori del programma. Gli autori cercheranno, nei limiti del
possibile, di venire incontro alle richieste sensate. Stante l'assoluta gratuità di questo software, non esistono hot-line ma solo il
Newsgroup. Gli utenti sappiano comunque che tutte le segnalazioni saranno tenute in adeguata considerazione.  Prima di inoltrare
domande, comunque, leggete l'Help. Purtroppo molti di questi quesiti dimostrano solamente che chi li ha postati non ha nemmeno
sfogliato queste pagine, che avrebbero invece potuto fornirgli la risposta senza bisogno di mettere un post nel Newsgroup. Il
rispondere a quesiti inutili ci fa perdere molto tempo che può essere impiegato più proficuamente per lo sviluppo del programma.
 
L'utilizzo di questo programma è subordinato ad un minimo di conoscenza dell'utilizzo di un PC in ambiente Windows. Oltre al
programma forniamo un Help sufficientemente esaustivo sia in formato HTML implementato nel programma stesso, che on-line
(necessaria una connessione Internet). Questo è tutto, gente. Ci dispiace ma non possiamo fornire lezioni di utilizzo del computer o
di Windows. Pertanto se non siete a conoscenza della terminologia e del funzionamento di base di un PC e del suo sistema
operativo, per favore non chiedete a noi, ma chiedete a qualche vostro amico di insegnarvelo. Grazie.
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